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About This Guide

This Novell® GroupWise® Troubleshooting 2 Guide provides troubleshooting strategies for 
GroupWise problems that can occur with GroupWise clients, GroupWise agents, message delivery, 
and ConsoleOne®. The guide is divided into the following sections:

• “General Troubleshooting Strategies” on page 9
• “Strategies for Agent Problems” on page 21
• “Strategies for Message Delivery Problems” on page 63
• “Strategies for Administration Problems” on page 87
• “Strategies for Client Problems” on page 97

Other sources of troubleshooting assistance include:

• Novell Support (http://support.novell.com)
• Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp)
• GroupWise 7 Support Forums (http://support.novell.com/forums/2gw.html)
• Novell GroupWise Support Community (http://support.novell.com/products/groupwise)
• GroupWise Cool Solutions (http://www.novell.com/coolsolutions/gwmag/index.html)

Audience

This guide is intended for network administrators who install and administer GroupWise. 

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

For the most recent version of GroupWise 7 Troubleshooting 2: Solutions to Common Problems, 
visit the Novell GroupWise 7 Documentation Web site (http://www.novell.com/documentation/
gw7).

Additional Documentation

For additional GroupWise documentation, see the following guides at the GroupWise 7 
documentation Web site (http://www.novell.com/documentation/lg/gw7):

• Installation Guide
• Administration Guide
• Multi-System Administration Guide
• Interoperability Guide
7
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• Troubleshooting 1: Error Messages
• Troubleshooting 3: Message Flow and Directory Structure
• GroupWise Client User Guides
• GroupWise Client Frequently Asked Questions (FAQ)

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (TM, ®, etc.) denotes a Novell trademark. An asterisk denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as Linux*, should use forward slashes as required by your software.

When a startup switch can be written with a forward slash for some platforms or a double hyphen for 
other platforms, the startup switch is presented with a forward slash. Users of platforms that require 
a double hyphen, such as Linux, should use double hyphens as required by your software.
7 Troubleshooting 2: Solutions to Common Problems
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IGeneral Troubleshooting 
Strategies

This part of Troubleshooting 2: Solutions to Common Problems helps you resolve GroupWise® 
problems that are not related to specific error messages or components of your system. It can also 
help with problems that have not been resolved by more specific troubleshooting strategies.

• Chapter 1, “General GroupWise Troubleshooting Strategies,” on page 11
• Chapter 2, “General Hardware/Network Troubleshooting Strategies,” on page 15
• Chapter 3, “Useful Linux Commands for Administering a GroupWise System,” on page 17

Other sources of assistance include:

• Novell® Support (http://support.novell.com)
• Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp)
• GroupWise 7 Support Forums (http://support.novell.com/forums/2gw.html)
• Novell GroupWise Support Community (http://support.novell.com/products/groupwise)
• GroupWise Cool Solutions (http://www.novell.com/coolsolutions/gwmag/index.html)
General Troubleshooting Strategies 9
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1General GroupWise 
Troubleshooting Strategies

• “Checking GroupWise Agent Log Files” on page 11
• “Assigning a GroupWise Administrator” on page 11
• “Checking IP Addresses and Port Numbers for TCP/IP Links” on page 11
• “Recovering and Rebuilding Domain and Post Office Databases” on page 12
• “Analyzing and Fixing User and Message Databases” on page 12
• “Verifying GroupWise System Information” on page 12
• “Understanding Message Flow” on page 13

Checking GroupWise Agent Log Files

Problem: You are experiencing message delivery problems.

Action: Use the POA and MTA log files to help you track message delivery problems. 
Set the logging level to Verbose so all processing information is displayed. 
This information can help you determine what the problem is. You should also 
verify that the information is being logged to disk. See the following sections 
in the GroupWise 7 Administration Guide.

• “Using POA Log Files” in “Post Office Agent”
• “Using MTA Log Files” in “Message Transfer Agent”
• “Using Internet Agent Log Files” in “Internet Agent”
• “Using WebAccess Log Files” in “WebAccess”
• “Configuring Monitor Agent Log Settings” in “Monitor”

Assigning a GroupWise Administrator

Problem: No one is receiving error messages generated by the MTA and the POA.

Action: Make sure each domain has an administrator who receives error messages 
generated by the agents. See “Notifying the Domain Administrator” in 
“Message Transfer Agent” in the GroupWise 7 Administration Guide.

Checking IP Addresses and Port Numbers for TCP/IP Links

Problem: Incorrect IP addresses and port numbers can cause problems for the 
GroupWise® client and agents when TCP/IP connections are used. 

Possible Cause: The GroupWise client is set up with the wrong IP address and/or TCP port 
number.

Action: Make sure the GroupWise client is set up with the correct IP address and port 
number for the POA in each user’s post office. See “Client” in the GroupWise 
7 Administration Guide.
General GroupWise Troubleshooting Strategies 11
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Action: Make sure the GroupWise name server is running so that IP addresses and port 
numbers can be looked up automatically. See the “Simplifying Client/Server 
Access with a GroupWise Name Server” in “Post Office Agent” in the 
GroupWise 7 Administration Guide.

Possible Cause: The POA is set up with the wrong IP address and/or TCP port number.

Action: Make sure the POA is set up with the correct IP address and port number. See 
“Using Client/Server Access to the Post Office” in “Post Office Agent” in the 
GroupWise 7 Administration Guide.

Possible Cause: The MTA is set up with the wrong IP address and/or TCP port number.

Action: Make sure the MTA is set up with the correct IP address and port number. See 
“Using TCP/IP Links between Domains” and “Using TCP/IP Links between a 
Domain and its Post Offices” in “Message Transfer Agent” in the GroupWise 7 
Administration Guide.

Possible Cause: Multiple programs on the same server are set up with the same TCP port 
number. 

Action: Make sure no duplicate port numbers are in use.

Recovering and Rebuilding Domain and Post Office Databases

Problem: Problems with a domain database (wpdomain.db) or post office database 
(wphost.db) can cause access problems for GroupWise Administrator and 
the GroupWise client, as well as cause message delivery problems. Database 
problems can also cause information in your system to be out of sync (for 
example, a user’s information in one post office being different than that user’s 
information in another post office). 

Action: See “Maintaining Domain and Post Office Databases” in “Databases” in the 
GroupWise 7 Administration Guide. 

Analyzing and Fixing User and Message Databases

Problem: Problems with a user database (userxxx.db) or a message database 
(msgnnn.db) can cause users to lose access to their mailboxes, have 
incorrectly displayed mailbox information, and have message delivery 
problems. 

Action: See “Maintaining User/Resource and Message Databases” in “Databases” and 
“GroupWise Check” in “Standalone Database Maintenance Programs” in the 
GroupWise 7 Administration Guide.

Verifying GroupWise System Information

Problem: Messages are not being delivered to post offices or domains, or you are 
receiving excessive undeliverable messages. 

Possible Cause: Link configuration problems with your GroupWise system can cause message 
delivery problems. 

Action: Check links between domains. See “Understanding Link Configuration” in 
“Domains” in the GroupWise 7 Administration Guide.
7 Troubleshooting 2: Solutions to Common Problems
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Action: Check links to post offices. See “Understanding Link Configuration” in 
“Domains” in the GroupWise 7 Administration Guide.

Possible Cause: Incorrect object information can cause message delivery problems.

Action: Check Domain and Post Office object properties. See the following sections in 
the GroupWise 7 Administration Guide:

• “Editing Domain Properties” in “Domains”
• “Editing Post Office Properties” in “Post Offices”

Action: Check Agent object properties. See the following sections in the GroupWise 7 
Administration Guide.

• “Configuring the POA in ConsoleOne” in “Post Office Agent” 
• “Configuring the MTA in ConsoleOne” in “Message Transfer Agent”
• “Configuring Internet Services” in “Internet Agent”
• “Configuring WebAccess Components” in “WebAccess”
• “Configuring the Monitor Agent” in “Monitor”

Possible Cause: Correct information is not being synchronized throughout your GroupWise 
system.

Action: If information is correct in some places but incorrect in others, you can 
synchronize GroupWise information. See “Synchronizing Database 
Information” in “Databases” in the GroupWise 7 Administration Guide.

Understanding Message Flow

Problem: You are experiencing message delivery problems. 

Action: Because each component (GroupWise client, POA and MTA) is responsible 
for a specific area of message flow, knowing where the message flow has been 
interrupted can help you discover which component is not functioning 
correctly. See “Message Flow Diagrams” in GroupWise 7 Troubleshooting 3: 
Message Flow and Directory Structure.
General GroupWise Troubleshooting Strategies 13
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2General Hardware/Network 
Troubleshooting Strategies

• “Checking Available System Resources” on page 15
• “Checking Available Disk Space” on page 15

Checking Available System Resources

Problem: The GroupWise® agents cannot perform well when inadequate system 
resources are available.

Action: Make sure the servers where agents run meet basic system requirements. See 
“GroupWise System Requirements” in “Installing a Basic GroupWise System” 
in the “GroupWise 7 Installation Guide”.

Checking Available Disk Space

Problem: When one of the GroupWise programs tries to create or modify a file and there 
is not enough disk space available to complete the task, you generally receive a 
disk full error message. 

Action: Free up space on the disk.
General Hardware/Network Troubleshooting Strategies 15
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3Useful Linux Commands for 
Administering a GroupWise 
System

Some GroupWise® administrators might be new to the Linux operating system. This section lists 
Linux commands that can help you manage your GroupWise system on Linux.

• Section 3.1, “Basic Commands,” on page 17
• Section 3.2, “File and Directory Commands,” on page 17
• Section 3.3, “Process Commands,” on page 18
• Section 3.4, “Disk Usage Commands,” on page 18
• Section 3.5, “Package Commands,” on page 19
• Section 3.6, “File System Commands,” on page 19
• Section 3.7, “Network Commands,” on page 19

3.1  Basic Commands
The following basic commands are available in GroupWise:

3.2  File and Directory Commands
The following file and directory commands are available in GroupWise:

Command Description

man command Displays information about any Linux command, including the commands used to 
start GroupWise programs.

whoami Displays who you are logged in as.

uname -a Displays the kernel version, along with other useful information

eject Ejects the CD from the drive.

Command Description

pwd Displays your current directory (“print working directory”).

ls -l Lists the files in the current directory, along with useful information 
about them.

ls -al Includes hidden system files (those whose names start with a dot) in the 
list.

more filename Pages through the contents of a file (forward only).
Useful Linux Commands for Administering a GroupWise System 17
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3.3  Process Commands
The following process commands are available in GroupWise:

3.4  Disk Usage Commands
The following disk usage commands are available in GroupWise:

less filename Pages through the contents of a file and lets you page back up through 
the file.

tail filename Displays the last 10 lines of a file. This is helpful for log files. (The head 
commands displays the first 10 lines.)

cp source destination Copies a file or directory.

mv source destination Moves or renames a file or directory. 

find starting_directory -name
filename

Find the specified file, starting in the specified directory. Specifying / 
would start the find operation in the root directory.

grep string file Searches the specified file for the specific string of characters. This is 
useful for locating specific information in GroupWise agent startup files.

mkdir directory_name Creates a new directory

rmdir directory_name Deletes an empty directory

rm filename Deletes a file

rm -r directory_name Deletes a directory and recursively deletes its contents.

cat filename Displays a file.

cat filename /printer_device Prints a file.

Command Description

top Lists all processes, sorted by CPU percentage with the highest at the top of 
the list.

ps -eaf | grep program Lists all processes and their IDs associated with the specified program. 
Wildcard characters can be used to list a group of related programs (for 
example, gw*).

ps -aux | grep username Lists all processes and their IDs associated with the specified user.

kill process_ID Stops the specified process like a normal exit.

kill -9 process_ID Stops the specified process after it has failed to exit normally. Temporary 
files are not cleaned up.

killall program Kills all processes associated with the specified program.

xkill Closes the window that you click on with the resulting box-shaped cursor.

Command Description
7 Troubleshooting 2: Solutions to Common Problems
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3.5  Package Commands
The following package commands are available in GroupWise:

3.6  File System Commands
The following file system commands are available in GroupWise:

3.7  Network Commands
The following network commands are available in GroupWise:

Command Description

df Lists file system disk space usage in terms that make sense to your computer.

df -h Lists file system disk space usage in terms that make sense to humans.

du Lists disk space usage of each subdirectory below your current working 
directory

du -s Lists the cumulative disk space usage of your current working directory.

du -s file_or_directory Lists the disk space usage for a file or the cumulative disk space usage for a 
directory and its contents.

Command Description

rpm -qa | grep novell Lists all Novell® packages installed on your server

rpm -qi package_name Lists useful information about an installed package, such as name, version, 
release date, install date, size description, build date, and so on.

rpm -ql package_name Lists where each file in the package has been installed

rpm -e package_name Uninstalls a package

Command Description

mount Lists the file systems that are currently mounted on 
your server.

mount -t ncpfs //NetWare_server_DNS_name 
/mountpoint_directory 
-o user=username
-o ipserver=server_IP_address 
-o server=server_hostname

Mounts a NetWare® server as a file system on your 
Linux server.

mount -t smbfs //Windows_server_name/share
 /mountpoint_directory
-o username=username

Mounts a Windows* server as a file system on your 
Linux server.
Useful Linux Commands for Administering a GroupWise System 19
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Command Description

ifconfig -a Lists the IP address and other detailed information about 
the NIC in your Linux server.

hostname Displays the hostname of your server.

dig Displays host information about your server

netstat -lnp | grep program
netstat -lnp | egrep ‘program|program|...'

Lists the port numbers in use by one or more programs. It 
is also a handy command for checking to see whether the 
specified programs are currently running.

ping IP_address_or_hostname Checks to see if the specified server is responding on the 
network.
7 Troubleshooting 2: Solutions to Common Problems
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IIStrategies for Agent Problems

This part of Troubleshooting 2: Solutions to Common Problems helps you resolve problems with 
individual agents, the Post Office Agent (POA) or the Message Transfer Agent (MTA), the Internet 
Agent, the WebAccess Agent, or the Monitor Agent. For more information, see the following 
sections:

• Chapter 4, “Post Office Agent Problems,” on page 23
• Chapter 5, “Message Transfer Agent Problems,” on page 33
• Chapter 6, “Internet Agent Problems,” on page 41
• Chapter 7, “WebAccess Agent Problems,” on page 57
• Chapter 8, “Monitor Agent Problems,” on page 61

Other sources of assistance include:

• Novell® Support (http://support.novell.com)
• Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp)
• GroupWise® 7 Support Forums (http://support.novell.com/forums/2gw.html)
• Novell GroupWise Support Community (http://support.novell.com/products/groupwise)
• GroupWise Cool Solutions (http://www.novell.com/coolsolutions/gwmag/index.html)
Strategies for Agent Problems 21
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4Post Office Agent Problems

For a list of error messages related to the Post Office Agent, see “Post Office Agent Error Messages” 
in GroupWise 7 Troubleshooting 1: Error Messages.

This section suggests ways to fix the following problems:

• “POA Won’t Start” on page 23
• “POA Shuts Down Unexpectedly” on page 25
• “POA Statistics Box Shows Requests Pending” on page 26
• “POA Statistics Box Shows Users Timed Out” on page 26
• “POA Statistics Box Shows Undeliverable Users” on page 26
• “POA Statistics Box Shows Problem Messages” on page 27
• “POA Redirection List Shows Failed TCP/IP Connection” on page 27
• “POA Message Transfer Status Box Shows Closed Link” on page 27
• “POA Starts Unwanted TCP/IP Thread” on page 28
• “POA Fails to Deliver Messages” on page 28
• “POA Fails to Respond to MTP Configuration Changes in ConsoleOne” on page 28
• “POA Fails to Respond to Other Configuration Changes in ConsoleOne” on page 29
• “POA Fails to Update the Post Office Database Version” on page 29
• “POA Runs Repeated Recoveries on the Same Database” on page 30
• “POA Starts in the Wrong Language” on page 30
• “POA Is Involved with Network Operating System or Hardware Problems” on page 30

POA Won’t Start

Problem: The POA does not start. 

Possible Cause: The /home switch is missing.

Action: Make sure the /home startup switch provides the correct path to the post office 
directory where the post office database (wphost.db) resides. This switch is 
required to start the POA and must be provided either in the POA startup file 
or on the command line when you start the POA. See “Installing and Starting 
the POA” in “Post Office Agent” in the GroupWise 7 Administration Guide.

Possible Cause: The /home switch points to an unavailable location.

Action: Make sure the location specified by the /home startup switch is currently 
available to the POA. If the post office is located on a different server from 
where the POA will run, preparations for the connection between the POA and 
the post office are required: 

• If you are using the NetWare® POA, you must use the /dn startup switch 
or the /user and /password startup switches to enable the POA to log in to 
the server where the post office is located, or you can provide the 
Post Office Agent Problems 23
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username and password in ConsoleOne®, on the Post Office Settings 
page of the Post Office object.

• If you are using the Linux POA, you must mount the file system where 
the post office is located to the server where the POA is running.

• If you are using the Windows POA, you must create the drive mapping to 
the post office before starting the POA.

See “Installing and Starting the POA” in “Post Office Agent” in the 
GroupWise 7 Administration Guide.

Possible Cause: The server where the post office resides is down.

Action: Check the status of the server where the post office resides.

Possible Cause: The POA does not have sufficient rights to the post office directory.

Action: Make sure the network rights in the post office are correct. Start the POA using 
the /rights switch to determine the specific problem the POA is encountering 
and make corrections as needed.

Possible Cause: The post office database (wphost.db) is damaged.

Action: If the post office database is available to the POA but cannot be read, it might 
be damaged. In ConsoleOne, perform database maintenance to correct any 
problems with the post office database. See “Maintaining Domain and Post 
Office Databases” in “Databases” in the GroupWise 7 Administration Guide.

Possible Cause: The POA server has inadequate resources.

Action: Make sure the server where you are trying to run the POA has adequate 
resources to run the POA, especially adequate available memory and the 
current versions of any required network system files. See “Agent System 
Requirements” in “Installing GroupWise Agents” in the “GroupWise 7 
Installation Guide”.

Use your operating system tools to check current server resources.

Possible Cause: The POA is not installed correctly.

Action: Make sure all files required to run the POA are installed. For a list of agent 
files, see “Agent Installation Directories” in GroupWise 7 Troubleshooting 3: 
Message Flow and Directory Structure.

Possible Cause: A remote document storage area is unavailable.

Action: Make sure the remote server where the document storage area is located is 
running. 

Action: Make sure the POA has sufficient rights to log in. 

Action: Make sure the /user and /password or /dn switches have been provided in the 
POA startup file.

Action: As a temporary workaround, you can start the POA with the /noconfig switch, 
so it can start without trying to access the remote document storage area.

Possible Cause: Language files are missing.

Action: If you are using the /language startup switch to run the POA in a particular 
language, the corresponding language files must be installed for the POA to 
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run in that language. To determine what language-specific files are required, 
see “Agent Installation Directories” in GroupWise 7 Troubleshooting 3: 
Message Flow and Directory Structure.

Possible Cause: A POA is already running on the server.

Action: If you have defined multiple POAs for the same post office in ConsoleOne, the 
/name switch is required in each startup file to specify which POA 
configuration to use when you start each instance of the POA.

Possible Cause: The POA encounters an error condition.

Action: If you receive an error message when trying to start the POA, look it up in 
“Post Office Agent Error Messages” in GroupWise 7 Troubleshooting 1: Error 
Messages.

POA Shuts Down Unexpectedly

Problem: The POA has been running smoothly, but stops unexpectedly. 

Action: If the POA agent console is still displayed, exit it. If the normal exit procedure 
does not work, use the system procedure for terminating a program. 

• If you are using the NetWare POA on NetWare, use the NetWare unload 
command. If you have other POAs running on the same server, you 
should exit them before using the unload command. The unload 
command unloads all POAs running on the same server and might not 
enable them to terminate gracefully. 

• If you are using the Linux POA, kill the first POA process. You might 
need to use kill -9.

• If you are using the Windows POA, close the POA window.

Action: After the POA agent console is no longer displayed, restart the POA as you 
normally would. See “Installing and Starting the POA” in “Post Office Agent” 
in the GroupWise 7 Administration Guide. If the POA shuts down again, exit it 
again, reboot the server, then start the POA again.

Action: Set the POA log level to Verbose for troubleshooting. See “Using POA Log 
Files” in “Post Office Agent” in the GroupWise 7 Administration Guide.

Possible Cause: Occasionally, a badly damaged message file can cause the POA to shut down.

Action: Check the contents of the POA input queue in the post office. For the location 
of the POA input queue in the post office, see “Post Office Directory” in 
GroupWise 7 Troubleshooting 3: Message Flow and Directory Structure. 

Move the message files out of the input queue subdirectories, start the POA, 
then copy the message files back in groups, watching the POA carefully to see 
if it shuts down on a particular message file. If it does, delete the problem 
message file so normal processing can resume.

Action: Rename the post_office\wpcsout\ofs directory, then start the POA. 
This creates a new, empty input queue and the POA should run smoothly. Then 
copy the message files from the 0-7 priority subdirectories of 
wpcsout\ofs back into the correct priority subdirectory so the POA can 
process them. Copy them in small groups so the damaged message file can be 
identified and removed.
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Possible Cause: Occasionally, a damaged database in the post office can cause the POA to shut 
down.

Action: In ConsoleOne, perform maintenance to correct any problems with the 
databases in the post office. See “Maintaining Domain and Post Office 
Databases” and “Maintaining User/Resource and Message Databases” in 
“Databases” in the GroupWise 7 Administration Guide.

Possible Cause: Although increasing the number of POA threads from their default settings 
can, in many cases, improve POA performance, creating too many POA 
threads can have undesirable results. 

Action: For guidance is setting an appropriate number of POA threads, see 
“Optimizing the POA” in “Post Office Agent” in the GroupWise 7 
Administration Guide.

Possible Cause: On a NetWare server, Upgrade Low Priority Threads is set to On.

Action: The POA might run more smoothly if you set Upgrade Low Priority Threads 
to Off. At the server console where the POA is running, type 
set upgrade low priority threads=off.

Possible Cause: Another program on the server is interfering with the operation of the POA.

Action: If the POA continues to be unstable, eliminate other programs running on the 
server. If the POA is stable when another specific program is not running on 
the same server with it, a conflict might exist between the two programs.

POA Statistics Box Shows Requests Pending

Problem: GroupWise client users are using TCP/IP links to the post office. At the POA 
console, the Statistics box shows a large number of pending client/server 
requests.

Action: Increase the number of POA connections so that more users can be serviced by 
the POA. See “Adjusting the Number of Connections for Client/Server 
Processing” in “Post Office Agent” in the GroupWise 7 Administration Guide.

POA Statistics Box Shows Users Timed Out

Problem: GroupWise client users are using TCP/IP links to the post office. At the POA 
console, the Statistics box shows a large number of users timed out. 

Action: Having users timed out does not indicate a problem with the POA, but rather a 
problem with users. Users who have timed out are users for which the POA 
has closed the connection because the GroupWise client was no longer 
communicating. Timed out users might not be exiting GroupWise normally or 
might be having other problems with their workstations. The number of timed-
out users might tend to increase on a daily basis during the hour after users 
leave to go home. This is not a problem.

POA Statistics Box Shows Undeliverable Users

Problem: At the POA console, the Statistics box shows a large number of undeliverable 
users. Undeliverable users can be encountered using either mapped drive 
connections or TCP/IP connections. Undeliverable users are counted 
differently from undeliverable messages. For example, a single message could 
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be addressed to 10 users; perhaps 9 users received the message successfully 
but 1 user was undeliverable. 

Possible Cause: If messages cannot be delivered to a particular user, that user might have a 
damaged user database (userxxx.db).

Action: In ConsoleOne, perform maintenance to correct any problems with the user 
database so messages can be delivered. See “Maintaining User/Resource and 
Message Databases” in “Databases” in the GroupWise 7 Administration Guide.

Action: Check the POA log file for other reasons why messages cannot be delivered to 
specific users. See “Using POA Log Files” in “Post Office Agent” in the 
GroupWise 7 Administration Guide.

POA Statistics Box Shows Problem Messages

Problem: At the POA console, the Statistics box shows that problem messages have been 
encountered. 

Action: The problem messages number indicates how many messages could not be 
processed by the POA. For strategies, see “Message Is Dropped in the problem 
Directory in the Post Office” on page 85.

POA Redirection List Shows Failed TCP/IP Connection

Problem: At the POA console, client/server statistics show a failed TCP/IP connection. 

Action: Under Client/Server Statistics, use Show Redirection List to list existing POAs 
and the IP addresses of the computers they are running on.

Action: Under Client/Server Statistics, use Check Redirection List to determine which 
connections are currently valid.

Action: If a connection is listed as failed for a POA, use the ping command to see if the 
server is alive. If the server does not respond to the PING command, you must 
resolve the TCP/IP problem before the POA can use the link successfully.

Possible Cause: TCP/IP is not functioning correctly on the POA server.

Action: If the POA is running on a Windows server, make sure TCP/IP is correctly 
installed and set up on the server where the POA is running.

Possible Cause: Multiple servers are trying to use the same IP address.

Action: Check for conflicting IP addresses between those used by POA servers and 
those used by other servers. Only one server at a time can use the same IP 
address.

POA Message Transfer Status Box Shows Closed Link

Problem: The POA is configured to communicate with the MTA by way of TCP/IP. 
However, the link between the POA and the MTA displays as Closed.

Action: Check the last closure reason. This information can help you determine the 
source of the problem. Common last closure reasons include:

Host refused connection
No peer listening for connection (B30A)
Port already in use (B309)
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TCP/IP connection failure (8908)
TCP/IP disconnected (890F)
TCP/IP read timeout (8912)

Action: See also “POA Fails to Respond to MTP Configuration Changes in 
ConsoleOne” on page 28.

POA Starts Unwanted TCP/IP Thread

Problem: Even though you have started the POA using the /notcpip startup switch or 
disabled the Enable TCP/IP option in the POA Agent Settings page in 
ConsoleOne, the POA still starts a TCP/IP thread. 

Explanation: When you select Client/Server Only or Client/Server and Direct as the access 
mode for a post office and use the /notcpip switch when starting a POA, that 
POA does not accept incoming client/server connections from GroupWise 
clients. However, it still starts a single TCP/IP handler thread if TCP/IP is 
configured on the server. The purpose of this TCP/IP thread is to notify any 
GroupWise clients connecting to another POA in the post office via TCP/IP 
they should reread the database because a new message has been delivered by 
a POA that is not using TCP/IP.

Action: To totally disable TCP/IP processing in a post office, set the access mode for 
the post office to Direct Only and start all POAs servicing that post office with 
the /notcpip switch, or deselect Enable TCP/IP in the Agent Settings page in 
ConsoleOne. 

POA Fails to Deliver Messages

Problem: The POA is running but no messages are being delivered.

Possible Cause: The post office is closed.

Action: From the MTA console, check the status of the post office from the point of 
view of the domain. See “Displaying MTA Status Information” in “Monitoring 
the MTA” in the GroupWise 7 Administration Guide. If the post office is 
closed, messages are not arriving in the post office. Correct the problem with 
the MTA. See “MTA Status Box Shows a Closed Location” on page 36.

Possible Cause: Message file processing has been turned off.

Action: Make sure that message file processing for the POA has not been turned off 
using the /nomf, /nomfhigh, or /nomflow switches.

POA Fails to Respond to MTP Configuration Changes in ConsoleOne

Problem: You change a POA link configuration or network address setting in 
ConsoleOne, but the POA does not respond to the change. For example, you 
change from a mapped or UNC link to a TCP/IP link between the POA and the 
MTA, or you move the POA to a different server and change its IP address. If 
the configuration change does not replicate successfully to the post office 
database, the MTA link to the post office becomes closed.

Action: If you do not want to stop and restart the POA to open a closed post office link, 
change the configuration information back to what it was before you tried to 
change it. The MTA should then be able to open the post office link again. 
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After communication between the POA and MTA is re-established, make the 
configuration changes again. Wait for the configuration changes to be 
replicated to the post office database (wphost.db), then start the POA in its 
new location.

Action: Stop the POA, then start the POA using the /mtpinipaddr and /mtpinport 
switches to specify the new IP address and port the POA should use for 
Message Transfer Protocol (MTP) communication with the MTA. After the 
link is established and all administrative messages have been processed, you 
do not need to use these startup switches again.

Action: Stop the POA. Rebuild the post office database (wphost.db) to replicate the 
configuration changes. See “Rebuilding Domain or Post Office Databases” in 
“Databases” in the GroupWise 7 Administration Guide.

POA Fails to Respond to Other Configuration Changes in ConsoleOne

Problem: You change a POA configuration setting in ConsoleOne, but the POA does not 
respond to the change. For example, you change from direct access to client/
server mode, or you want to turn off error mail to the administrator.

Action: Synchronize the post office database (wphost.db) with the domain database 
(wpdomain.db). See “Synchronizing Database Information” in “Databases” 
in the GroupWise 7 Administration Guide.

Action: Stop the POA. Rebuild the post office database (wphost.db) to replicate the 
configuration changes. See “Rebuilding Domain or Post Office Databases” in 
“Databases” in the GroupWise 7 Administration Guide.

POA Fails to Update the Post Office Database Version

Problem: You are updating the agent software on a server where both the POA and the 
MTA are running. The MTA successfully updates the database version for the 
domain but the POA fails to update the database version for the post office.

Possible Cause: You let the Installation program start both agents automatically. As a result, the 
POA checked the domain version in the post office database before it had a 
chance to process the administrative message from the MTA that would update 
the domain version in the post office database.

Action: Wait until the MTA has updated the domain database. For a large domain 
database, you might need to wait as much as 20 minutes or more. Verify that 
the database version has been updated by checking the Domain object’s 
Identification page in ConsoleOne, then stop and restart the POA to update the 
post office database. Check the Post Office object’s Identification page in 
ConsoleOne to verify that the database version has been updated.

Action: If restarting the POA does not update the post office database version:

1 Compare the dates on the .dc files (gwpo.dc and ngwguard.dc) in 
the post office directory with the dates on the .dc files in the update 
source (the GroupWise 7 Administrator CD or the software distribution 
directory if it has been updated from the GroupWise 7 Administrator CD).

2 If the dates on the .dc files in the post office are older than the dates on the 
.dc files in the update source, copy the .dc files from the update source 
into the post office directory. 
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3 At the POA console, recover the post office database. See “Recovering 
the Post Office Database Automatically or Immediately” in “Post Office 
Agent” in the GroupWise 7 Administration Guide.
When the recovery process is finished, the database version should be 
updated.

4 View the Post Office object’s Identification page in ConsoleOne to verify 
that the database version has been updated.

POA Runs Repeated Recoveries on the Same Database

Problem: The POA continually attempts to recover a particular database but never 
succeeds.

Action: The recovery operation that the POA can perform while the database is in use 
is not as powerful as a rebuild operation. Rebuild the problem database. See 
“Maintaining Domain and Post Office Databases” and “Maintaining User/
Resource and Message Databases” in “Databases” in the GroupWise 7 
Administration Guide.

Action: If the problem is occurring with a user database and it cannot be rebuilt, re-
create the user database. See “Re-creating a User Database” in “Databases” in 
the GroupWise 7 Administration Guide.

POA Starts in the Wrong Language

Problem: You have installed the POA in more than one language and it is starting in a 
different language than you want.

Action: Start the POA using the /language switch to specify the language.

POA Is Involved with Network Operating System or Hardware Problems

Problem: The POA is interacting with the network operating system or hardware in an 
undesirable way.

Possible Cause: If you just updated the NetWare® POA software, you might not have unloaded 
the agent engine (gwenn5.nlm), resulting in a series of Loader cannot 
find public symbol: symbol errors on the server console. 

Action: Unload gwenn5.nlm, then start the NetWare POA, so that the newly 
installed agent engine is loaded along with it.

Possible Cause: The NetWare POA server is running older software, resulting in 
TCP_HANDLER errors on the server console. 

Action: Make sure you are using the most current TCP/IP stack for NetWare.

Possible Cause: The POA server is overburdened, resulting in SYN attacks.

Action: Make sure overall server utilization is not too high. Increase the POA’s TCP/IP 
resources. See “Adjusting the Number of Connections for Client/Server 
Processing” in “Post Office Agent” in the GroupWise 7 Administration Guide.

Possible Cause: The POA server is overburdened. CPU utilization on the server where the 
NetWare POA is running jumps to 100% and the POA seems to be taking all 
available resources. GroupWise and other objects on the server are out of sync 
with other servers.
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Action: Run DSREPAIR.
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5Message Transfer Agent Problems

For a list of error messages related to the Message Transfer Agent, see “Message Transfer Agent 
Error Messages” in GroupWise 7 Troubleshooting 1: Error Messages.

This section suggests ways to fix the following problems:

• “MTA Won’t Start” on page 33
• “MTA Shuts Down Unexpectedly” on page 35
• “MTA Status Box Shows a Closed Location” on page 36
• “MTA Statistics Box Shows Undeliverable Messages” on page 37
• “MTA Statistics Box Shows Errors” on page 37
• “MTA Configuration Status Isn’t Open” on page 37
• “MTA Fails to Update the Domain Database Version” on page 38
• “MTA Starts in the Wrong Language” on page 39
• “MTA Is Involved with Network Operating System or Hardware Problems” on page 39

MTA Won’t Start

Problem: The MTA does not start.

Possible Cause: The /home switch is missing.

Action: Make sure the /home startup switch provides the correct path to the domain 
directory where the domain database (wpdomain.db) resides. This switch is 
required to start the MTA and must be provided either in the MTA startup file 
or on the command line when you start the MTA. See “Installing and Starting 
the MTA” in “Message Transfer Agent” in the GroupWise 7 Administration 
Guide.

Possible Cause: The /home switch points to an unavailable location.

Action: Make sure the location specified by the /home startup switch is currently 
available to the MTA. If the domain is located on a different server from where 
the MTA will run, preparations for the connection between the MTA and the 
domain are required:

• If you are using the NetWare® MTA, you must use the /dn startup switch 
or the /user and /password startup switches to enable the MTA to log in to 
the server where the domain is located.

• If you are using the Linux MTA, mount the file system where the domain 
is located to the server where the MTA is running.

• If you are using the Windows MTA, you must create the drive mapping to 
the domain and post offices in the domain before starting the MTA.

Possible Cause: The server where the domain resides is down.

Action: Check the status of the server where the domain resides.
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Possible Cause: The /work switch points to an unavailable location. Although not required, the 
/work startup switch is useful to specify a local working directory for the MTA 
when the domain it services is located on a different server. Using the /work 
switch to provide a local working directory on the server where it is installed is 
highly recommended for MTA performance. If the /work switch is not used, 
the working directory is placed in the directory specified by the /home switch.

Action: Make sure the location of the MTA working directory is available to the MTA.

Possible Cause: The MTA does not have sufficient rights to the domain directory.

Action: Make sure the network rights in the domain are correct. 

Possible Cause: The domain database (wpdomain.db) is damaged.

Action: If the domain database (wpdomain.db) is available to the MTA but cannot 
be read, it might be damaged. In ConsoleOne®, perform maintenance to 
correct any problems with the domain database. See “Maintaining Domain and 
Post Office Databases” in “Databases” in the GroupWise 7 Administration 
Guide.

Possible Cause: The MTA server has inadequate resources.

Action: Make sure the server where you are trying to run the MTA has adequate 
resources to run the MTA, especially adequate available memory and the 
current versions of any required network system files. See “Agent System 
Requirements” in “Installing GroupWise Agents” in the “GroupWise 7 
Installation Guide”.

Possible Cause: The MTA is not installed correctly.

Action: Make sure all files required to run the MTA are installed. For a complete list, 
see “Agent Installation Directories” in GroupWise 7 Troubleshooting 3: 
Message Flow and Directory Structure.

Possible Cause: Language-specific files are missing.

Action: If you are using the /language startup switch to run the MTA in a particular 
language, the corresponding language files must be installed for the MTA to 
run in that language. To determine what language-specific files are required, 
see “Agent Installation Directories” in GroupWise 7 Troubleshooting 3: 
Message Flow and Directory Structure.

Possible Cause: The MTA is encountering a problem with one specific aspect of its 
functioning.

Action: MTA startup switches are available to disable specific MTA functions while 
allowing other functions to continue normally. For example, the /noada switch 
disables the MTA admin thread. If a specific MTA function is causing the 
MTA to shut down, you might be able to disable that particular function with a 
startup switch. See “Using MTA Startup Switches” in “Message Transfer 
Agent” in the GroupWise 7 Administration Guide.

Possible Cause: The MTA encounters an error condition.

Action: If you receive an error message when trying to start the MTA, look it up in 
“Message Transfer Agent Error Messages” in GroupWise 7 Troubleshooting 1: 
Error Messages.
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MTA Shuts Down Unexpectedly

Problem: The MTA has been running smoothly, but stops unexpectedly. 

Action: If the MTA agent console is still displayed, exit it. If the normal exit procedure 
does not work, use the system procedure for terminating a program. 

• If you are using the NetWare MTA, use the NetWare unload command. If 
you have other MTAs running on the same server, you should exit them 
before using the unload command. The unload command unloads all 
MTAs running on the same server and might not enable them to terminate 
gracefully. 

• If you are using the Linux MTA, kill the first MTA process. You might 
need to use kill -9.

• If you are using the Windows MTA, close the MTA window.

Action: After the MTA agent console is no longer displayed, restart the MTA as you 
normally would. See “Installing and Starting the MTA” in “Message Transfer 
Agent” in the GroupWise 7 Administration Guide.

Action: If the MTA shuts down again, exit it again, reboot the server, then start the 
MTA again.

Action: Set the MTA log level to Verbose for troubleshooting. See “Using MTA Log 
Files” in “Message Transfer Agent” in the GroupWise 7 Administration Guide. 

Possible Cause: Occasionally, a badly damaged message file can cause the MTA to shut down.

Action: Check the contents of the MTA input queues in the domain and post offices. 
For the locations of the MTA input queues, see “Message Transfer/Storage 
Directories” in GroupWise 7 Troubleshooting 3: Message Flow and Directory 
Structure. 

Move the message files out of the priority subdirectories of each input queue, 
start the MTA, then copy the message files back in groups, watching the MTA 
carefully to see if it shuts down on a particular message file. If it does, delete 
the problem message file so normal processing can resume.

Possible Cause: Occasionally, a damaged domain database (wpdomain.db) can cause the 
MTA to shut down.

Action: In ConsoleOne, perform maintenance to correct any problems with the domain 
database. See “Maintaining Domain and Post Office Databases” in 
“Databases” in the GroupWise 7 Administration Guide.

Possible Cause: Network connections are unstable.

Action: Make sure the connections between the server where the MTA is running and 
the servers where the domain database (wpdomain.db) and post office 
database (wphost.db) are located are stable. Repeatedly losing connections 
to servers can cause damage to databases.

Possible Cause: The MTA is encountering a problem with one specific aspect of its 
functioning.

Action: MTA startup switches are available to disable specific MTA functions while 
allowing other functions to continue normally. For example, the /noada switch 
disables the MTA admin thread. If a specific MTA function is causing the 
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MTA to shut down, you might be able to disable that particular function with a 
startup switch. See “Using MTA Startup Switches” in “Message Transfer 
Agent” in the GroupWise 7 Administration Guide.

Possible Cause: Another program on the server is interfering with the operation of the MTA.

Action: If the MTA continues to be unstable, eliminate other programs running on the 
server. If the MTA is stable when another specific program is not running on 
the same server with it, a conflict might exist between the two programs.

MTA Status Box Shows a Closed Location

Problem: At the MTA agent console, the Status box shows a closed location. 

Action: Check for details about why the location is closed. See “Displaying MTA 
Status Information” in “Message Transfer Agent” in the GroupWise 7 
Administration Guide. 

Action: Check the configuration status for the closed location. See “MTA 
Configuration Status Isn’t Open” on page 37.

Action: Check the last closure reason. This information can help you determine the 
source of the problem. Common last closure reasons include:

Access denied
Cannot attach to server or volume
Cannot create/read/write files/directories
Cannot move files
Insufficient disk space
Insufficient memory
Insufficient system resources
Link or transport down
No path configured
Undefined link

For more information, see “Message Transfer Agent Error Messages” in 
GroupWise 7 Troubleshooting 1: Error Messages.

Action: In Configuration Status Details, check the directory paths for mapped and 
UNC connections or the IP addresses and port numbers for TCP/IP links. 
Make sure the correct locations are displayed. Make sure the locations exist, 
and verify that the database (wpdomain.db for a domain or wphost.db for 
a post office) is there in the specified location. Do not use eDirectoryTM paths.

Action: If it is a new location that has never been open, verify the links between 
domains and post offices. See “Understanding Link Configuration” in 
“Domains” in the GroupWise 7 Administration Guide. Make sure mapped and 
UNC path specifications are in the correct format. Do not use eDirectory full 
context paths.

Possible Cause: A domain or post office has been moved incorrectly.

Action: When you move a domain or post office to a new location or change its link 
type, you must make various configuration changes in ConsoleOne. If the 
domain or post office becomes closed as a result, the reconfiguration changes 
might not have replicated down to the agent in the reconfigured location before 
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other changes prevented the replication from happening at all. Rebuild the 
location database (wpdomain.db or wphost.db). See “Rebuilding 
Domain or Post Office Databases” in “Databases” in the GroupWise 7 
Administration Guide. This ensures that the reconfiguration changes are 
replicated to the location. Then restart the agent for the location.

Possible Cause: The MTA server has insufficient memory.

Action: Make sure the server where the MTA is running has adequate memory. If the 
MTA starts running out of memory, it starts shutting down connections. See 
“Agent System Requirements” in “Installing GroupWise Agents” in the 
“GroupWise 7 Installation Guide”. 

MTA Statistics Box Shows Undeliverable Messages

Problem: At the MTA agent console, the Statistics box displays a large number of 
undeliverable messages. 

Action: The number of undeliverable messages indicates how many messages could 
not be routed by the MTA. For strategies, see “Message Has Undeliverable 
Status” on page 81. 

MTA Statistics Box Shows Errors

Problem: At the MTA agent console, the Statistics box shows a large number of message 
errors have occurred. 

Action: The number of message errors indicates how many messages could not be 
processed by the MTA. For strategies, see “Message Is Dropped in the 
problem Directory” on page 85. 

MTA Configuration Status Isn’t Open

Problem: At the MTA agent console, the Configuration Status box displays the 
connection status as something other than Open. 

Action: If the configuration status is Closed, the MTA cannot access the database in the 
domain or post office. Make sure the server where the closed location resides 
is not down. Make sure the MTA can access the server. 

Action: If the connection status is Suspended, resume the MTA. See “Suspending/
Resuming MTA Processing for a Location” in “Message Transfer Agent” in 
the GroupWise 7 Administration Guide.

Action: If the connection status is Open Pending, post offices in the domain are in the 
process of opening and the MTA is clearing its holding queues. After this is 
accomplished, the MTA begins processing current messages and the status 
changes to Open. No action is necessary.

NetWare: Verify the settings of the /dn or /user and /password startup switches 
for the server where the closed location resides.

Windows: Verify the UNC path or drive mapping to the closed location.
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MTA Fails to Update the Domain Database Version

Problem: You are updating the MTA software in a secondary domain and the MTA fails 
to update the database version for the domain. You might see conflicting 
database version information depending on whether you are connected to the 
secondary domain or the primary domain.

Possible Cause: You installed and started the MTA for the secondary domain before the MTA 
for the primary domain had finished updating the primary domain database.

Action: Wait until the MTA for the primary domain has finished updating the primary 
domain database. For a large domain database, you might need to wait as much 
as 20 minutes or more. Verify that the primary domain database version has 
been updated by checking the Domain object’s Identification page in 
ConsoleOne. Then stop and restart the MTA for the secondary domain to 
update the secondary domain database.

Action: If restarting the MTA for the secondary domain does not update the domain 
database version:

1 Compare the dates on the .dc files (gwdom.dc and gwpo.dc) in the 
secondary domain directory with the dates on the .dc files in the update 
source (the GroupWise 7 Administrator CD or the software distribution 
directory if it has been updated from the GroupWise 7 Administrator CD).

2 If the dates on the .dc files in the secondary domain are older than the 
dates on the .dc files in the update source, copy the .dc files from the 
update source into the domain directory. 

3 At the MTA console, recover the domain database. See “Recovering the 
Domain Database Automatically or Immediately” in “Message Transfer 
Agent” in the GroupWise 7 Administration Guide.
When the recovery process is finished, the database version should be 
updated.

4 In ConsoleOne, connect to the secondary domain, then check the Domain 
object’s Identification page to verify that the database version has been 
updated.

5 Connect to the primary domain database, then check the Identification 
page for the primary domain to verify that the database version 
information matches in both domain databases. 

Action: If recovering the secondary domain database does not update the version, then 
connect to the primary domain and rebuild the secondary domain database. 
See “Rebuilding Domain or Post Office Databases” in “Databases” in the 
GroupWise 7 Administration Guide.

Possible Cause: There are one or more closed links between the secondary domain and the 
primary domain that are preventing the administrative messages from flowing 
between the domains to accomplish the database version update.

Action: Check the links between the domains and open any closed links. See “MTA 
Configuration Status Isn’t Open” on page 37. After all links are open, recover 
the secondary domain database. See “Recovering the Domain Database 
Automatically or Immediately” in “Message Transfer Agent” in the 
GroupWise 7 Administration Guide.
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MTA Starts in the Wrong Language

Problem: You have installed the MTA in more than one language and it is starting in a 
different language than you want.

Action: Start the MTA using the /language switch to specify the language.

MTA Is Involved with Network Operating System or Hardware Problems

Problem: The MTA is interacting with the network operating system or hardware in an 
undesirable way.

Possible Cause: If you just updated the MTA software, you might not have unloaded the agent 
engine (gwenn5.nlm), resulting in a series of Loader cannot find 
public symbol: symbol errors on the server console. 

Action: Unload gwenn5.nlm, then start the MTA, so that the newly installed agent 
engine is loaded along with it.

Possible Cause: The MTA server is running older software, resulting in TCP_HANDLER 
errors on the server console. 

Action: Make sure you are using the most current TCP/IP stack for NetWare.

Possible Cause: The MTA server is overburdened, resulting in SYN attacks.

Action: Make sure overall server utilization is not too high. Increase the MTA’s 
tolerance for slow connections. See “Adjusting the MTA Wait Intervals for 
Slow TCP/IP Connections” in “Message Transfer Agent” in the GroupWise 7 
Administration Guide.
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6Internet Agent Problems

This section suggests ways to fix the following problems:

• “No Relay Host Connectivity from the Target Server” on page 41
• “No Internet Connectivity from the Target Server” on page 43
• “Target Server Could Not Perform DNS Resolution” on page 45
• “Target Server Not Configured for TCP/IP” on page 46
• “Invalid or Unspecified Internet Host Name” on page 47
• “Unverified Host Name for Target Server” on page 47
• “RFC Compliance: Specify a Postmaster” on page 48
• “Log Files” on page 48
• “SMTP Statistics” on page 48
• “Internet Agent Not Sending Messages” on page 49
• “Internet Agent Not Receiving Messages” on page 50
• “Internet Agent Locking Up” on page 50
• “Internet Agent Cannot Access the Domain” on page 51
• “Internet Agent Doesn’t Send Outgoing Mail” on page 52
• “Internet Agent Fails to Respond to Configuration Changes Made in ConsoleOne” on page 52
• “Administrator Wants to Prevent Certain Types of Messages from Passing through the Internet 

Agent” on page 52
• “POP3 Client Users Can’t Send Internet Mail through the Internet Agent” on page 52
• “POP3 Client Users Can’t Access the GroupWise Address Book through the LDAP Services of 

the Internet Agent” on page 53
• “IMAP4 Client Users Can’t Access Mail through the Internet Agent” on page 54
• “Extended Characters in User Names Prevent Delivery through the Internet Agent” on page 54
• “Messages Sent Out through the Internet Agent Don’t Wrap When Displayed by Recipients” 

on page 54
• “The Internet Agent Cannot Communicate with the Message Transfer Agent (MTA)” on 

page 54
• “The Internet Agent Displays a 450 MX Record Lookup Failure” on page 55
• “The Internet Agent Experiences a Problem with Rules Causing Looping” on page 56

No Relay Host Connectivity from the Target Server

Problem: During installation, the Internet Agent Installation program was not able to 
contact a mail process on the specified relay host. You can fix the problem 
after the Internet Agent has been installed.

Possible Cause: The server where you installed the Internet Agent is not yet configured for 
TCP/IP.
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Action: On a NetWare® server:

1 Load INETCFG.
2 In the Internetworking Configuration box, select Protocols > TCP/IP.
3 Select Enabled.
4 Exit INETCFG.
5 Restart the server.

Refer to the NetWare documentation at the Novell® Documentation Web site 
(http://www.novell.com/documentation) for more information about 
configuring TCP/IP on NetWare.

Action: On a Windows server:

NOTE: Steps may vary, depending on your version of Windows.

1 Right-click My Network Places, click Properties, then double-click Local 
Area Connection.

2 Check the list for Internet Protocol (TCP/IP).
3 If TCP/IP is not in the list, click Add, then follow the instructions for 

installing TCP/IP.
or
If TCP/IP is listed, select it, then check the existing configuration 
information for accuracy.

4 Click OK to save any changes you have made.
5 Restart the server.

Refer to your Windows documentation for more information about installing 
TCP/IP on Windows.

Possible Cause: The server where you installed the Internet Agent cannot communicate with 
the relay host because the default router is not properly configured.

Action: On a NetWare server, if you are configuring TCP/IP in the autoexec.ncf 
file, add gateway=router_ip_address to the BIND statement.

If you are using INETCFG to configure TCP/IP:

1 Load INETCFG.
2 In the Internetworking Configuration box, select Protocols.
3 In the Protocol Configuration box, select TCP/IP.
4 In the TCP/IP Protocol Configuration box:

4a Enable Static Routing.
4b Select Static Routing Table.
4c Press Enter.

5 In the TCP/IP Static Routes box, press Insert to add a new static route.
6 In the Static Route Configuration box:

6a Press Enter in the Route Type field to display a list of route types.
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6b Select Default Route.
6c Select Next Hop Router on Route, then press Enter to edit the field.
6d Type the IP address of the default router, then press Enter.
6e Press Esc twice.

7 Select Yes, then press Enter to update the INETCFG database.
8 Press Esc until prompted to exit INETCFG.
9 Select Yes, then press Enter.

10 Restart the server to put the new default router into effect.

Refer to the NetWare documentation at the Novell Documentation Web site 
(http://www.novell.com/documentation) for more information about using 
INETCFG.

Action: On a Windows server:

NOTE: Steps may vary, depending on your version of Windows.

1 Click Start > Settings > Control Panel.
2 Double-click Network and Dial-Up Connections, then click Local Area 

Connection. 
3 Select TCP/IP Protocol, then click Properties.
4 In the Default Gateway field, specify the IP address of the default router 

on your network.
5 Click OK.
6 Restart the server to put the new default gateway information into effect.

Refer to your Windows documentation for more information about installing 
TCP/IP on Windows.

Possible Cause: There is no SMTP mail service listening at the IP address of the relay host.

Action: Start the mail service on the relay host.

Action: Specify a different relay host.

No Internet Connectivity from the Target Server

Problem: During installation, the Internet Agent Installation program was not able to 
connect to the Internet. You can fix the problem after the Internet Agent has 
been installed.

Possible Cause: The server where you installed the Internet Agent is not yet configured for 
TCP/IP.

Action: On a NetWare server:

1 Load INETCFG.
2 In the Internetworking Configuration box, select Protocols, then select 

TCP/IP.
3 Select Enabled.
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4 Exit INETCFG.
5 Restart the server.

Refer to the NetWare documentation at the Novell Documentation Web site 
(http://www.novell.com/documentation) for more information about 
configuring TCP/IP on NetWare.

Action: On a Windows server:

NOTE: Steps may vary, depending on your version of Windows.

1 Right-click My Network Places, click Properties, then double-click Local 
Area Connection.

2 Check the list for Internet Protocol (TCP/IP).
3 If TCP/IP is not in the list, click Add, then follow the instructions for 

installing TCP/IP.
or
If TCP/IP is listed, select it, then check the existing configuration 
information for accuracy.

4 Click OK to save any changes you have made.
5 Restart the server.

Refer to your Windows documentation for more information about installing 
TCP/IP on Windows.

Possible Cause: The server where you installed the Internet Agent cannot communicate with 
the Internet because the default router is not properly configured.

Action: On a NetWare server, if you are configuring TCP/IP in the autoexec.ncf 
file, add gateway=router_ip_address to the BIND statement.

If you are using INETCFG to configure TCP/IP:

1 Load INETCFG.
2 In the Internetworking Configuration box, select Protocols.
3 In the Protocol Configuration box, select TCP/IP.
4 In the TCP/IP Protocol Configuration box: 

4a Enable Static Routing.
4b Select Static Routing Table.
4c Press Enter.

5 In the TCP/IP Static Routes box, press Insert to add a new static route.
6 In the Static Route Configuration box:

6a Press Enter in the Route Type field to display a list of route types.
6b Select Default Route.
6c Select Next Hop Router on Route, then press Enter to edit the field.
6d Type the IP address of the default router, then press Enter.
6e Press Esc twice.
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7 Select Yes, then press Enter to update the INETCFG database.
8 Press Esc until prompted to exit INETCFG.
9 Select Yes, then press Enter.

10 Restart the server to put the new default router into effect.

Refer to the NetWare documentation at the Novell Documentation Web site 
(http://www.novell.com/documentation) for more information about using 
INETCFG.

Action: On a Windows server:

NOTE: Steps may vary, depending on your version of Windows.

1 Right-click My Network Places, click Properties, then double-click Local 
Area Connection.

2 Select Internet Protocol (TCP/IP), then click Properties.
3 In the Default Gateway field, specify the IP address of the default router 

on your network.
4 Click OK.
5 Restart the server to put the new default gateway information into effect.

Refer to your Windows documentation for more information about setting up a 
default router on Windows.

Possible Cause: A firewall is blocking SMTP traffic.

Action: Configure the firewall to allow outbound messages to pass if the source IP 
address is the IP address of the server where you installed the Internet Agent. 
Also configure the firewall to allow inbound messages to pass if the 
destination IP address is the IP address of the server where you installed the 
Internet Agent. In both cases, the required port number is 25.

Action: As needed, configure the firewall to accept the following additional types of 
traffic: POP3 (port 110), IMAP4 (port 143), or LDAP (port 389).

Possible Cause: You are using a dial-up connection to the Internet and it is not configured to 
dial on demand.

Action: Refer to the documentation accompanying the dial-up router or contact the 
router software vendor.

Target Server Could Not Perform DNS Resolution

Problem: During installation, the Internet Agent Installation program determined that 
the server where you installed the Internet Agent cannot resolve DNS (Domain 
Name Service) host names. You can fix the problem after the Internet Agent 
has been installed.

Possible Cause: The server where you installed the Internet Agent is not yet configured for 
DNS.

Action: On a NetWare server, make sure that DNS has been set up as described in 
“Internet Connectivity Requirements” in “Installing the GroupWise Internet 
Agent” in the “GroupWise 7 Installation Guide”.
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Action: On a Windows server: 

NOTE: Steps may vary, depending on your version of Windows.

1 Right-click My Network Places, click Properties, then double-click Local 
Area Connection.

2 Select Internet Protocol (TCP/IP), then click Properties > DNS.
3 Add or correct DNS information as needed.
4 Click OK to save any changes you have made.

Refer to your Windows documentation for more information about setting up 
DNS on Windows.

Possible Cause: The DNS server is down or otherwise unavailable.

Action: Contact the administrator of the DNS server to resolve the issue.

Action: Configure the server where you are installing the Internet Agent to use a 
different DNS server.

Target Server Not Configured for TCP/IP

Problem: During installation, the Internet Agent Installation program determined that 
the server where you installed the Internet Agent is not configured for TCP/IP. 
You can fix the problem after the Internet Agent has been installed.

Action: On a NetWare server:

1 Load INETCFG.
2 In the Internetworking Configuration box, select Protocols > TCP/IP.
3 Select Enabled.
4 Exit INETCFG.
5 Restart the server.

Refer to the NetWare documentation at the Novell Documentation Web site 
(http://www.novell.com/documentation) for more information about 
configuring TCP/IP on NetWare.

Action: On a Windows server:

NOTE: Steps may vary, depending on your version of Windows.

1 Right-click My Network Places, click Properties, then double-click Local 
Area Connection.

2 Check the list for Internet Protocol (TCP/IP).
3 If TCP/IP is not in the list, click Add, then follow the instructions for 

installing TCP/IP.
or
If TCP/IP is listed, select it, then check the existing configuration 
information for accuracy.

4 Click OK to save any changes you have made.
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5 Restart the server.

Refer to your Windows documentation for more information about installing 
TCP/IP on Windows.

Invalid or Unspecified Internet Host Name

Problem: During installation, you did not specify a valid Internet host name for the 
Internet Agent to use when resolving Internet addresses. You can fix the 
problem after the Internet Agent has been installed.

Possible Cause: The Internet host name is not yet stored in eDirectory.

Action: In ConsoleOne®, browse to and right-click the GWIA object, then click 
Properties. Click GroupWise > Identification. In the Foreign ID field, provide 
the Internet host name of your company (for example, Novell.com).

Possible Cause: The host name you provided has not been registered and published by your 
ISP.

Action: Contact your ISP to find out when your hostname will be published. Make sure 
that your ISP has associated the correct IP address with your host name. Verify 
the contents of the MX and A records for your host name.

Possible Cause: Your host name as been published for less than 24 hours and your DNS server 
is still using cached information.

Action: Wait a day and try again.

Possible Cause: Inbound mail is routed through a relay host.

Action: You can ignore this warning if the relay host is configured to forward messages 
to the server where the Internet Agent is installed.

Action: If the relay host uses aliasing to forward messages to the server where the 
Internet Agent is installed, you must configure the Internet Agent to handle the 
alias. In ConsoleOne, browse to and right-click the GWIA object, then click 
Properties. Click GroupWise > Identification. In the Foreign ID field, provide 
the alias along with the Internet host name of your company. Separate the 
hostnames with a space.

Unverified Host Name for Target Server

Problem: During installation, the Internet Agent Installation program determined that 
the server where you installed the Internet Agent does not have a host name. 
You can fix the problem after the Internet Agent has been installed.

Action: On a NetWare server, make sure that the server where you installed the Internet 
Agent is listed in the sys:\etc\hosts file, including its host name and IP 
address.

Action: On a Windows server:

NOTE: Steps may vary, depending on your version of Windows.

1 Right-click My Network Places, click Properties, then double-click Local 
Area Connection.

2 Select Internet Protocol (TCP/IP), then click Properties > DNS.
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3 Fill in the Host Name and Domain fields.
4 Click OK to save any changes you have made.

Refer to your Windows documentation for more information about setting up 
DNS on Windows.

RFC Compliance: Specify a Postmaster

Problem: During installation, you did not specify a postmaster for the Internet Agent to 
send error notifications to. You can fix the problem after you have finished 
installing the Internet Agent.

Action: Follow the instructions in “Assigning a Postmaster ” in “Installing the 
GroupWise Internet Agent” in the “GroupWise 7 Installation Guide”.

Log Files

Explanation: The log file is a useful tool for diagnosing problems. It is an ASCII file that 
records Internet Access activity and provides a variety of configuration, 
message flow, and productivity information. The log file contains the same 
information that scrolls in the message log portion of the of the Internet Agent 
console. 

Action: You can adjust the amount of information a log file records using the Log 
Settings page in ConsoleOne, the log startup switches, or the keystroke menu 
in the Internet Agent console. For more information, see “Using Internet Agent 
Log Files” in “Internet Agent” in the GroupWise 7 Administration Guide.

SMTP Statistics

Explanation: The Statistics screen, which is accessed from the Internet Agent console, lists 
numbers of error and informational messages. Most of these messages are 
informational only. 

Action: Use the information on the Statistics screen to help you resolve Internet Agent 
problems.

Messages Sent/Messages Received:  These fields display the number of 
messages the Internet Agent has sent and received. 

Send Threads/Receive Threads:  These fields display the number of 
currently active send and receive threads the Internet Agent is using to process 
outgoing and incoming messages. If the number of send or receive threads 
currently in use is consistently close to the total number allocated, you might 
want to increase the total number of send or receive threads. 

Send Thr Avail/Receive Thr Avail:  These fields display the number of 
available send and receive threads of the total number allocated. 

MX Lookup Errs:  This field displays the number of times the Internet Agent 
queries the Domain Name Server (DNS) for the address of the destination host 
and receives a SERVER FAIL code message back from the DNS. These 
messages are deferred and automatically re-queued according to the retry 
schedule. 
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Unless the number of MX Lookup Errors is very significant, do not be 
concerned by these messages. If the number of messages is very significant, 
you might want to check the DNS to make sure the tables are not corrupted. If 
you’re using a remote DNS, you might consider setting up a local DNS server. 
It could also mean that your file server TCP/IP is not correctly configured. 

Unknown Hosts:  This field displays the number of times the Internet Agent 
attempted to do a lookup on a destination host and the host name did not exist 
in either the DNS records or in the host table. The Internet Agent sends back a 
non-deliverable message to the sender for each Unknown Host message. 

TCP/IP Read Errs/ TCP/IP Write Errs:  These fields display the number of 
TCP/IP read or write errors indicating some communication problem occurred. 
This is a temporary error. These messages are deferred and automatically re-
queued according to the retry schedule. Unless the number of TCP/IP read or 
write errors is very significant, do not be concerned by these messages. If the 
number of messages is very significant, you might want to contact your 
Internet service provider to check for anything that could hinder 
communication, such as network problems or line noise. You might also want 
to adjust the timeout switches, particularly the /te and /tr switches. 

Hosts Down:  This field displays the number of times the Internet Agent tried 
to open a connection with the destination host and received a connection 
refused status. This is a temporary error. These messages are deferred and 
automatically re-queued according to the Retry Schedule. 

The statistics count the number of times a code or SMTP reply, such as Host 
Down, comes back to the Internet Agent. It does not keep track of the mail 
messages causing these replies. If, for example, a message is deferred and re-
queued for four days during the Retry Schedule, each attempt the program 
makes to send the message results in another SMTP reply or error code. 

Retry Schedule:  If an Internet host is down or the connection is not made on 
the Internet, the Internet Agent defers the message and re-queues it according 
to the retry schedule. The Internet Agent program places the message in the 
\wpgate\gwia\defer directory for 20 minutes. Then it transfers the file 
to the send directory for another attempt at sending to the Internet. The 
Internet Agent makes this attempt three times in one hour and then every four 
hours for four days. After the four days, if the Internet host remains down, an 
undeliverable status is sent back to the sender. 

Internet Agent Not Sending Messages

Problem: Messages are not returned to the user’s Sent Items folder as undeliverable, and 
the recipients are not receiving the messages.

Action: Make sure the Internet Agent is running and is correctly configured in 
ConsoleOne. 

Action: Make sure the Message Transfer Agent is running. 

Action: Make sure the Internet Agent can access the GroupWise® domain directory. 

Action: Make sure the program is properly configured. Check the startup file to verify 
that the /dhome switch is pointing to the Internet Agent directory. 
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Action: Check the statistics from the Internet Agent console. If any of the fields, such 
as TCP/IP Read or Write Errors or MX Lookup Errors, have a very significant 
number, you might want to contact your Internet service provider. See “SMTP 
Statistics” on page 48 for more information. 

Action: Check the log file for error messages. You might want to set the log level to 
Diag and resend problem messages. See “Internet Agent Error Messages” in 
GroupWise 7 Troubleshooting 1: Error Messages for more information. 

Action: Make sure the resolv.cfg file is set up correctly. See “Internet 
Connectivity Requirements” in “Installing the GroupWise Internet Agent” in 
the “GroupWise 7 Installation Guide”.

Internet Agent Not Receiving Messages

Problem: The Internet Agent is not receiving messages from the Internet.

Action: Make sure the Internet Agent directory has sufficient network rights. 

Action: Make sure the Internet Agent can access the GroupWise domain database. 

Action: Make sure the Internet Agent has rights to the domain directory and that the 
Internet Agent can access all its subdirectories. 

Action: Make sure the program is properly configured. Check the startup file to verify 
that the /dhome switch is pointing to the Internet Agent directory. 

Action: Check if you can ping the Internet Agent server from another Internet server. 

Action: Send a test message from a UNIX* Internet computer using the sendmail -v 
option. The -v option shows all the SMTP reply codes for the message. For 
example, use the following syntax:

echo test | /usr/lib/sendmail -v user@host 

Internet Agent Locking Up

Problem: The Internet Agent locks up or hangs.

Possible Cause: Bad message file 

Possible Cause: Bad configuration file in the 000.prc directory 

Possible Cause: Bad domain record

Possible Cause: Bad domain user record

Possible Cause: Software incompatibility 

Possible Cause: Hardware failure 

Action: Check the dates of the executables and make sure you are using the most 
current software and patches. Apply the latest versions for the Internet Agent 
as well as for the TCP/IP kernel. Make sure you meet the minimum version 
and system requirements for the operating system. 

Action: Check for bad message files. Move all files currently in any queues in the 
send, receive, defer, result, wpcsin, wpcsout, or 
000.prc\gwwork directories and let the Internet Agent run idle without 
processing any messages. If the Internet Agent can run idle without locking, a 
bad message is probably causing it to lock. Start copying the files back to the 
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appropriate directory queues starting with the newest file to the oldest. This 
approach assumes the oldest file caused the lock and allows the Internet Agent 
to process the messages that got backed up before dealing with the bad file. 
Delete the bad file when you find it. Because the file is encrypted, there is no 
way to determine who sent the message. 

Action: Check for a bad configuration file. One of the setup files in the 000.prc 
directory might be damaged and therefore causing problems. Before removing 
or changing anything, back up your directories. Be sure to back up any files 
you want in the 000.prc directory such as the log and accounting files. 
Remove all the files in the 000.prc and restart the Internet Agent. If you had 
set a screen color or screen saver, you must reset these settings after removing 
the SET file. 

Action: Remove directories and have the Message Transfer Agent and the Internet 
Agent re-create new ones. Be sure to back up the whole GWIA directory and 
all subdirectories before deleting anything. Shut down the Internet Agent and 
the Message Transfer Agent. Remove the send, receive, defer, 
result, wpcsin, wpcsout, 000.prc directories. Restart the Message 
Transfer Agent first to re-create the wpcsin and wpcsout directories, then 
restart the Internet Agent to re-create the other directories (empty). This 
approach is often effective for solving locking problems, although it is not very 
effective for isolating and determining what is causing the problem. 

Action: If the Internet Agent continues to lock after removing and re-creating the 
directories, you might want to rebuild the domain database for the domain 
where the Internet Agent is installed in case there are database structural 
problems. If it’s a primary domain database, you must rebuild the database 
from itself. If it’s a secondary domain database, you can rebuild it from the 
primary domain database or rebuild it from itself. See “Rebuilding Domain or 
Post Office Databases” in “Databases” in the GroupWise 7 Administration 
Guide.

Action: Run the Internet Agent on a different server that is already set up and running 
well (without problems with requestors, network interface cards, and so on). If 
the Internet Agent runs well with the same configuration on a different server, 
then the hardware is probably causing problems. 

Internet Agent Cannot Access the Domain

Problem: The Internet Agent cannot access its input and output queues in the domain. 

Explanation: When the domain is located on a remote NetWare server, the Internet Agent 
must be started with the /user and /password switches so it can log in to the 
remote server. 

Action: Make sure these switches have been specified in the Internet Agent .cfg file.

Action: Make sure the user has sufficient rights to access the 
\domain\wpgate\gwia directory. 

Action: Make sure the password is correct and current.
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Internet Agent Doesn’t Send Outgoing Mail

Problem: The Internet Agent seems to receive and process messages, but never sends 
them. 

Action: If you are using an external domain to simplify addressing for your users, 
make sure the external domain type is set to Non-GroupWise Domain, not 
External Domain. In ConsoleOne, in the GroupWise View, delete the external 
domain, then create a non-GroupWise domain.

Internet Agent Fails to Respond to Configuration Changes Made in ConsoleOne

Problem: You change an Internet Agent access control setting in ConsoleOne, but the 
Internet Agent does not respond to the change. 

Action: Exit, then restart the Internet Agent so it rereads its access control database 
(gwac.db).

Administrator Wants to Prevent Certain Types of Messages from Passing through 
the Internet Agent

Problem: Message flow through the Internet Agent is being hindered because large 
numbers of undesirable types of messages are passing through.

Explanation: You want to prevent messages larger than a specified size from coming into the 
GroupWise system through the Internet Agent.

Action: In ConsoleOne, browse to and select the domain where the Internet Agent is 
installed. Right-click the Internet Agent object, then click Properties > Access 
Control. Double-click Default Class of Service.

Exit, then restart the Internet Agent.

Action: To restrict the size of incoming messages, click SMTP Incoming, select Allow 
Incoming Messages, select Prevent Messages Larger than X Kbytes, specify 
the maximum message size in kilobytes, then click OK.

Exit, then restart the Internet Agent.

Action: To restrict the size of outgoing messages, click SMTP Outgoing, select Allow 
Outgoing Messages, select Prevent Messages Larger than X Kbytes, specify 
the maximum message size in kilobytes, then click OK.

Exit, then restart the Internet Agent.

Explanation: By default, the Internet Agent downloads only 100 messages at a time. You 
want to increase or decrease this number.

Action: In ConsoleOne, browse to and select the Domain object where the Internet 
Agent is installed. Right-click the Internet Agent object, then click Properties. 
Click Access Control, then double-click Default Class of Service. Click POP3, 
modify the setting in the Maximum Number of Messages to Download field as 
needed (valid settings range from 1 to 1000), then click OK. 

Exit, then restart the Internet Agent. 

POP3 Client Users Can’t Send Internet Mail through the Internet Agent

Problem: Users of POP3 mail clients are unable to send mail through the Internet Agent. 
7 Troubleshooting 2: Solutions to Common Problems



novdocx (E
N

U
)  01 February 2006
Possible Cause: Allow Message Relaying has been turned off. 

Action: Make sure Allow Message Relaying is turned on. In ConsoleOne, browse to 
and select the Domain object where the Internet Agent is installed. Right-click 
the Internet Agent object, then click Properties. Click Access Control > SMTP 
Relay, select Allow Message Relaying, then click OK. 

Exit, then restart the Internet Agent.

POP3 Client Users Can’t Access the GroupWise Address Book through the LDAP 
Services of the Internet Agent

Problem: POP3 client users cannot look up addresses using the LDAP directory services 
created in their browser.

Possible Cause: If you are using Netscape Communicator*, the Search Root setting does not 
match the Internet Agent LDAP Context setting.

Action: First, check the Search Root setting. In Netscape Communicator, click 
Edit > Preferences > Mail & Groups > Directory > GroupWise Address 
Book > Edit. Check the setting in the Search Root field. Note the current 
setting; it can be anything. Then, check the Internet Agent LDAP Context 
setting. In ConsoleOne, browse to and select the Domain where the Internet 
Agent is installed. Right-click the Internet Agent object, then click 
Properties. Click Advanced Settings. Make sure the setting in the LDAP 
Context field matches the setting in the Netscape Communicator Search Root 
field.

Possible Cause: If you are using Internet Explorer, the Search Base setting does not match the 
Internet Agent LDAP Context setting.

Action: First, check the Search Base setting. In Internet Explorer, click File > New 
Message > Mail > Choose Recipients > Find. Right-click in the Search 
window, then click Directory Services from the pop-up list. Click GroupWise 
Address Book > Properties > Advanced. Check the setting in the Search Base 
for this Directory Service field. It can be anything; it defaults to c=US. Then, 
check the Internet Agent LDAP Context setting. In ConsoleOne, browse to and 
select the Domain object where the Internet Agent is installed. Right-click the 
Internet Agent object, then click Properties. Click Advanced Settings. Make 
sure the setting in the LDAP Context field matches the setting in the Internet 
Explorer Search Base field.

Possible Cause: The Internet Agent does not have access to a post office to retrieve information 
from the GroupWise Address Book by accessing a post office database 
(wphost.db). 

Action: In ConsoleOne, browse to and select the Domain object where the Internet 
Agent is installed. Right-click the Internet Agent object, then click Properties. 
Click Access Control > LDAP Public, then make sure a valid post office has 
been specified. Make sure the post office access mode includes direct access. 
Make sure that message file processing has not been turned off. See “Adjusting 
the Number of POA Threads for Message File Processing” in “Post Office 
Agent” in the GroupWise 7 Administration Guide.
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IMAP4 Client Users Can’t Access Mail through the Internet Agent

Problem: Users are unable to access GroupWise mail using IMAP4 from a browser 
because they are unable to log in.

Action: The user has Server Supports Encrypted Connections (SSL) turned on. In the 
user’s browser, check the setting for Server Supports Encrypted Connections 
(SSL). This is not currently supported by the Internet Agent. Deselect this 
option in the user’s browser. For example, in Netscape Communicator, click 
Edit > Preferences > Mail & Groups > Mail Server, then deselect Server 
Supports Encrypted Connections (SSL) in the Mail Server Type box.

Extended Characters in User Names Prevent Delivery through the Internet Agent

Problem: Messages arriving from the Internet through the Internet Agent addressed to 
recipients who have extended characters in their user names are undeliverable.

Explanation: User names are part of message header files. According to RFC822 and 
RFC1521 standards, text in header fields must be composed of printable 
ASCII characters. 

Action: As a workaround, create a nickname for affected users without the extended 
characters. See “Creating a Nickname for a User” in “Users” in the GroupWise 
7 Administration Guide.

Messages Sent Out through the Internet Agent Don’t Wrap When Displayed by 
Recipients

Problem: Recipients of GroupWise messages sent across the Internet through the 
Internet Agent complain that the messages do not wrap correctly when viewed 
in their e-mail client software.

Action: Enable line wrapping in the recipient’s e-mail software.

Action: To specify how you want lines to wrap when displayed by the recipient, 
browse to and select the Domain object where the Internet Agent is installed. 
Right-click the Internet Agent object, then click Properties. Click SMTP/
MIME Settings > Message Formatting, specify a setting for Line Wrap Length 
for Message Text on Outbound Mail, then click OK. 

You can also specify the line wrap setting using the /wrap switch in the Internet 
Agent startup file (gwia.cfg). 

The line wrap setting affects only RFC822-formatted messages, not MIME 
messages.

The Internet Agent Cannot Communicate with the Message Transfer Agent (MTA)

Problem: The Internet Agent is not receiving messages to send out across the Internet.

Explanation: The Message Transfer Agent distributes messages between post offices, 
gateways, and domains. A Message Transfer Agent is required in each domain. 
If the Message Transfer Agent is offline, outgoing messages are queued in the 
Message Transfer Agent directories. When the Message Transfer Agent is 
brought online, all queued messages are routed.
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Action: Make sure the Message Transfer Agent is running and transferring messages. 
See “Monitoring the MTA” in “Message Transfer Agent” in the GroupWise 7 
Administration Guide.

Action: Make sure the Message Transfer Agent is correctly configured in ConsoleOne. 
See “Configuring the MTA” in “Message Transfer Agent” in the GroupWise 7 
Administration Guide.

Action: Check the Message Transfer Agent console or the Message Transfer Agent log 
files. Both of these sources provide a detailed record of Message Transfer 
Agent operations. See “Using the MTA Server Console” and “Using MTA Log 
Files” in “Message Transfer Agent” in the GroupWise 7 Administration Guide.

Action: Check the Status portion of the MTA agent console to find out whether the 
domain, post office, or gateway is closed. See “MTA Status Box Shows a 
Closed Location” on page 36. 

Action: Make sure you can send messages between post offices. See “Message Does 
Not Arrive between Post Offices” on page 65.

The Internet Agent Displays a 450 MX Record Lookup Failure 

Problem: The Internet Agent has requested a lookup from the Domain Name Server and 
did not get a response.

Action: Check the resolv.cfg file for correct configuration. 

The resolv.cfg file should be in the following format: 

domain your_domain_name 
nameserver ip_address
nameserver ip_address 
nameserver ip_address 

The domain name is first, followed by up to three nameserver IP addresses. 
The following is a sample resolv.cfg file: 

domain sgunix.org 
nameserver 172.16.5.18 

Possible Cause: The IP address to your DNS has changed.

Action: Update the resolv.cfg file. 

Possible Cause: TCP/IP is configured incorrectly. 

Possible Cause: There is a problem with your network interface card. 

Possible Cause: There is a problem with your network cabling. 

Possible Cause: The DNS server is down. 

Possible Cause: IP filtering has been added to the routers so the Internet Agent cannot see the 
DNS server. 

Action: Ping the nameserver IP address to see if it is reachable from the gateway 
station. 

Action: Ping the LAN segment router IP address. 
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Action: Make sure the named Internet Agent program is running on the nameserver 
server. 

Possible Cause: Outbound ports are disabled. TCP/IP can use port 1024 through 2099 or some 
other range of outbound ports for sending.

Action: Check with your Internet service provider for the outbound ports it uses. 

The Internet Agent Experiences a Problem with Rules Causing Looping

Problem: An infinite message loop can occur when a user has turned on a rule 
automatically replying to messages. If a message is then sent to another user 
who has an automatic reply rule, or to a list server, an infinite loop can occur. 

Explanation: GroupWise has built-in counters to prevent most infinite loops, primarily those 
occurring within the GroupWise system. The following safeguards have been 
implemented by the GroupWise Internet Agent to prevent the looping of 
messages that go through the gateway: 

• Messages generated by a rule now have the From address changed to 
POSTMASTER@foreign_name. 

• A Reply To: field has been added with the real user address so most 
mailers will reply to the user, but list servers that reply to the From 
address will reply to the postmaster instead. 

• An Errors To: field has been added with the POSTMASTER foreign 
name address. With this field, undeliverable messages won’t be sent to a 
mailbox that has a rule associated with it. 

• If a message is sent to a user that is defined on a foreign domain or 
gateway, the Reply To: field will contain the postmaster’s actual resolved 
address. This allows the postmaster message to get to a postmaster who 
might not be on the GroupWise system. 

Action: The infinite loop protection built into GroupWise might not work for some 
messages going through the gateway to Internet list servers. Such infinite 
loops must be resolved on a case-by-case basis. 
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7WebAccess Agent Problems

This section suggests ways to fix the following problems:

• “GroupWise WebAccess Login Screen Does Not Appear” on page 57
• “Initial GroupWise WebAccess Screen Does Not Appear” on page 57
• “User is Logged Out of GroupWise WebAccess” on page 58
• “User Receives Invalid User ID or Password Error Message” on page 58
• “WebAccess Agent Cannot Access a Post Office” on page 58
• “WebAccess Agent Doesn’t Create Log Files” on page 58
• “WebAccess Agent Shuts Down Unexpectedly” on page 59
• “WebAccess Agent Does Not Start” on page 59
• “WebAccess Client Doesn’t Print Messages” on page 59
• “WebAccess Speller Doesn’t Work” on page 59
• “WebAccess Users Want to Skip the Language Selection Page” on page 59
• “Messages Viewed through WebAccess Client Could Be Viewed through Browser’s Cache” on 

page 60

GroupWise WebAccess Login Screen Does Not Appear

Explanation: When a user clicks a language button on the initial GroupWise® WebAccess 
screen, the login screen does not appear.

Action: Make sure the commgr.cfg file is in the cgi-bin\gw7 of the Web Server. 
See “Configuring the WebAccess Agent” and “Configuring the WebAccess 
Application” in “WebAccess” in the GroupWise 7 Administration Guide. 

If you are running the GroupWise WebAccess CGI Extension on a Novell® 
Web server, make sure the srm.cfg file (in the web\config directory, where web 
is the Web server’s root directory) includes the following line:

loadablemodule /cgi-bin/gw7/gwweb.exe 
sys:web/cgi-bin/gw7/gwweb.nlm

where web is the Web server’s root directory and us is the language code. You 
must have an entry for each language you have installed. See “Specifying a 
WebAccess Agent in the WebAccess URL” in “WebAccess” in the GroupWise 
7 Administration Guide.

Initial GroupWise WebAccess Screen Does Not Appear

Explanation: When a user enters the IP address or host name of the Web server, the initial 
GroupWise WebAccess page does not appear.

Action: Make sure the user is typing the correct IP address or hostname.
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User is Logged Out of GroupWise WebAccess

Explanation: A GroupWise WebAccess user is automatically logged out of GroupWise 
WebAccess after a period of time.

Action: Each user has a timeout period after which he or she is logged out if he or she 
has not used GroupWise WebAccess. By default, this timeout period is 20 
minutes. If necessary, you can modify the timeout setting. See “Controlling 
User Access to Mailboxes” in “WebAccess” in the GroupWise 7 
Administration Guide.

User Receives Invalid User ID or Password Error Message

Explanation: When logging in to GroupWise WebAccess, a user receives an invalid user ID 
or invalid password error.

Action: Make sure the user entered his or her GroupWise user ID or full name (as 
defined in eDirectory and the GroupWise Address Book). Make sure the user 
has a password on his or her mailbox and that the password was entered 
correctly. Passwords are case sensitive.

Action: Make sure the user has access to GroupWise WebAccess. See “Controlling 
User Access to Mailboxes” in “WebAccess” in the GroupWise 7 
Administration Guide.

Action: Make sure the WebAccess Agent has access to the user’s post office. See 
“Managing Access to Post Offices” in “WebAccess” in the GroupWise 7 
Administration Guide.

WebAccess Agent Cannot Access a Post Office

Explanation: When processing a request from a user, the WebAccess Agent could not access 
the user’s post office.

Action: Make sure the link information for the post office is defined in ConsoleOne®. 
See “Managing Access to Post Offices” in “WebAccess” in the GroupWise 7 
Administration Guide.

Action: If the WebAccess Agent is using direct access to the post office, make sure it 
has a user account that provides access to the post office server and appropriate 
rights to the post office directory structure. See “Domain and Post Office 
Access” in “Installing GroupWise WebAccess” in the “GroupWise 7 
Installation Guide”.

Action: If the WebAccess Agent is using client/server access to the post office, make 
sure TCP/IP is set up on the servers running the WebAccess Agent and the 
Post Office Agent. See “Configuring the WebAccess Agent” in “WebAccess” 
and “Configuring the POA” in “Post Office Agent” in the GroupWise 7 
Administration Guide.

Action: Make sure login to the post office is not disabled. See “Disabling a Post 
Office” in “Post Offices” in the GroupWise 7 Administration Guide.

WebAccess Agent Doesn’t Create Log Files

Explanation: Disk logging is turned off by default, so the WebAccess Agent doesn’t 
automatically create log files.
7 Troubleshooting 2: Solutions to Common Problems



novdocx (E
N

U
)  01 February 2006
Action: To enable and configure disk logging, see “Configuring the WebAccess 
Agent” in “WebAccess” in the GroupWise 7 Administration Guide.

WebAccess Agent Shuts Down Unexpectedly

Explanation: The WebAccess Agent (gwinter) has been running smoothly, but stops 
unexpectedly.

Action: If the WebAccess Agent is connecting to the post office directly, its processing 
can be disrupted by damaged databases just like the POA. To protect the 
stability of the WebAccess Agent, you can configure it to communicate with 
the POA by way of TCP/IP in client/server mode only, thus disallowing direct 
database accesses. See “Modifying Links to Post Offices” in “WebAccess” in 
the GroupWise 7 Administration Guide.

WebAccess Agent Does Not Start

Explanation: The WebAccess Agent does not start.

Action: Edit the strtweb.ncf or strtweb.bat file. Make sure the /home startup 
switch includes the complete path to domain\wpgate\webacc, where 
domain is the path to the domain directory and webacc is the gateway home 
directory.

Action: For the NetWare® WebAccess Agent, make sure the /user and /password 
startup switches include the user ID and password for an account that gives the 
WebAccess Agent access to the domain directory.

Action: For the WebAccess Agent, make sure the server is connected to the server 
where the domain directory resides.

WebAccess Client Doesn’t Print Messages

Explanation: When printing a message in the Java* version of the WebAccess client, only 
the header gets printed.

Explanation: The Java version of the WebAccess client uses an applet to display messages. 
Not all browsers can print applets. 

Action: Run the HTML version of the WebAccess client to print messages.

WebAccess Speller Doesn’t Work

Explanation: WebAccess users are unable to spell check their messages.

Action: Spell checking capabilities are not automatically set up when WebAccess is 
installed. For setup instructions, see “Configuring the Novell Speller 
Application” in “WebAccess” in the GroupWise 7 Administration Guide.

WebAccess Users Want to Skip the Language Selection Page

Explanation: By default, the WebAccess client starts on a page where you choose your 
display language. On a system where only one language is available, this is an 
unnecessary step.

Action: After selecting the language, users can create a bookmark to the main 
WebAccess login page, so they never need to select the language again.
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Action: Create a link directly to the WebAccess login page from some other page 
convenient to users. 

Messages Viewed through WebAccess Client Could Be Viewed through Browser’s 
Cache

Explanation: Some users might consider it a security breach that messages originally viewed 
through the WebAccess client could be viewed later through their browser’s 
cache.

Explanation: The configuration of the browser cache and history list is each user’s 
responsibility.

Action: To set cache options in Mozilla Firefox, click Tools > Options > Privacy, then 
configure history and cache settings as needed to meet your security concerns.

Action: To set cache options in Internet Explorer, click View > Internet 
Options > Temporary Internet Files > Settings. Configure caching as needed 
to meet your security concerns. To control the length of your history list, click 
View > Internet Options > History, then set Days to Keep Pages in History as 
needed.
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8Monitor Agent Problems

This section suggests ways to fix the following problem:

• “Monitor Agent Won’t Start” on page 61

Monitor Agent Won’t Start

Problem: The Monitor Agent does not start.

Possible Cause: The /home switch is missing.

Action: Make sure the /home startup switch provides the correct path to the domain 
directory where the domain database (wpdomain.db) resides. See “Starting 
the Monitor Agent” in “Monitor” in the GroupWise 7 Administration Guide.

Possible Cause: The server where the domain resides is down.

Action: Check the status of the server where the domain resides.

Possible Cause: The domain database (wpdomain.db) is damaged.

Action: If the domain database (wpdomain.db) is available to the Monitor Agent but 
cannot be read, it might be damaged. In ConsoleOne®, perform maintenance 
to correct any problems with the domain database. See “Maintaining Domain 
and Post Office Databases” in “Databases” in the GroupWise 7 Administration 
Guide.

Possible Cause: The Monitor Agent encounters an error condition.

Action: If you receive an error message when trying to start the Monitor Agent, look it 
up in “Monitor Agent and Application Error Messages” in GroupWise 7 
Troubleshooting 1: Error Messages.
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IIIStrategies for Message Delivery 
Problems

This part of Troubleshooting 2: Solutions to Common Problems helps you resolve problems with 
how the agents are interacting to deliver messages throughout your GroupWise® system and covers 
the following sections:

• Chapter 9, “Message Does Not Arrive,” on page 65
• Chapter 10, “Message Delivery Is Slow,” on page 77
• Chapter 11, “Message Has Undeliverable Status,” on page 81
• Chapter 12, “Message Is Dropped in the problem Directory,” on page 85

Other sources of assistance include:

• Novell® Support (http://support.novell.com)
• Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp)
• GroupWise 7 Support Forums (http://support.novell.com/forums/2gw.html)
• Novell GroupWise Support Community (http://support.novell.com/products/groupwise)
• GroupWise Cool Solutions (http://www.novell.com/coolsolutions/gwmag/index.html)
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9Message Does Not Arrive

This section suggests ways to fix the following problems:

• “Message Does Not Arrive in the Local Post Office” on page 65
• “Message Does Not Arrive between Post Offices” on page 65
• “Message Does Not Arrive between Domains” on page 69
• “Message Does Not Arrive Across the Internet” on page 74

Message Does Not Arrive in the Local Post Office

Problem: A message from user A is not being delivered to user B in the same post office. 
This scenario would most likely occur when GroupWise® users connect to the 
post office using direct access mode. Direct access for clients is not 
recommended for GroupWise 7. 

Action: If you are having problems with direct access using GroupWise 7, see the 
GroupWise 5.5 Troubleshooting 2: Solutions to Common Problems (http://
www.novell.com/documentation/lg/gw55/index.html).

Message Does Not Arrive between Post Offices

Problem: A message from a user in Post Office A is not being delivered to a user in Post 
Office B in the same domain. 

Action: Review the stages of message flow between post offices. See “Message 
Delivery to a Different Post Office” in GroupWise 7 Troubleshooting 3: 
Message Flow and Directory Structure.

Action: Answer the following question:

Problem with an Individual User in Either Post Office 

1 Stop the MTA for the domain.
2 Have the user in Post Office A send a low priority test message to a 

recipient in Post Office B. (It’s a good idea to test message flow using a 
low priority message because the low priority message queue is typically 
empty.)

3 Check the post_office\wpcsin\6 directory in the sender’s post 
office.

Can other users in Post Office A send messages to other users in Post Office B? 

Yes See “Problem with an Individual User in Either Post Office” on 
page 65.

No See “Problem between Post Offices for Multiple Users” on page 67.

Don/t Know See “Problem between Post Offices for Multiple Users” on page 67.
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4 Stop the POA for Post Office B.
5 Restart the MTA in the domain. Observe the MTA agent console for any 

sign of problems.
6 Check the post_office\wpcsout\ofs\6 directory in Post Office 

B.

7 Restart the POA for Post Office B. Observe the POA agent console for 
any sign of problems.

8 Recheck the post_office\wpcsout\ofs\6 directory in Post 
Office B.

9 Check the recipient’s mailbox. 

10 Check the ownership of the recipient’s user database (userxxx.db).

Has a new message file appeared in the post_office\wpcsin\6 directory?

No The GroupWise client was unable to create the message file. 
The user might not have sufficient rights to the directory if using 
direct access mode. Correct the problem, then repeat the test.

Yes The sender can successfully send messages. Continue below.

Has a new message file appeared in the post_office\wpcsout\ofs\6 
directory?

No See “Problem between Post Offices for Multiple Users” on 
page 67.

Yes The message transferred successfully between post offices. 
Continue below.

Has the message file disappeared from the post_office\wpcsout\ofs\6 
directory?

No The POA was unable to pick up the message. Correct the 
problem, then repeat the test.

Yes The POA has successfully picked up the message. Continue 
below.

Does the new message appear in the recipient’s mailbox?

Yes The POA has successfully delivered the message this time. 
Repeat the test with a different user.

No The POA was unable to deliver the message. Continue 
below.
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11 Check the ownership of the message database (msgnnn.db) in the 
recipient’s post office that corresponds to the message database assigned 
to the sender in the sender’s post office.

12 In ConsoleOne®, perform maintenance to correct any problems with the 
databases. See “Maintaining User/Resource and Message Databases” in 
“Databases” in the GroupWise 7 Administration Guide. Then repeat the 
test. 

13 If the message flow problem has not been resolved by following the 
above troubleshooting steps, see Novell® Support  (http://
support.novell.com).

Problem between Post Offices for Multiple Users 

1 Stop the MTA for the domain.
2 Have the user in Post Office A send a low priority test message. (It’s a 

good idea to test message flow using a low priority message because the 
low priority message queue is typically empty.) 

3 Check the post_office\wpcsin\6 directory in Post Office A. 

4 Stop the POA for Post Office B.
5 Restart the MTA for the domain. Observe the MTA agent console for any 

sign of problems.
6 Check the post_office\wpcsout\ofs\6 directory in Post Office 

B.

 Does the ownership of the user database match the recipient’s network login 
ID?

No Reset the ownership on the userxxx.db file, then repeat the 
test.

Yes Continue below.

Is the ownership of the message database correct?

No Reset the ownership on the msgnnn.db, then repeat the 
test.

Yes Continue below.

Has a new message file appeared in the post_office\wpcsin\6 directory?

No See “Problem with an Individual User in Either Post Office” 
on page 65.

Yes The sender can successfully send messages. Continue 
below.
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7 Restart the POA for Post Office B. Observe the POA agent console for 
any sign of problems.

8 Recheck the post_office\wpcsout\ofs\6 directory in Post 
Office B. 

Problem with Access to Post Office B 

1 Start ConsoleOne with read/write rights to the post office.
2 Open the browser window.
3 Double-click the eDirectoryTM container where the domain is located, 

then select the Domain object. 
4 Click Tools > GroupWise Utilities > Link Configuration.
5 Check the link from the domain to Post Office B. 

6 If you are using client/server access to Post Office B, check the IP address 
and port displayed in the Network Address box of the POA Identification 
page.

Has a new message file appeared in the post_office\wpcsout\ofs\6 
directory? 

No See “Problem with Access to Post Office B” on page 68.

Yes The MTA has successfully transferred the file to the POA in 
the recipient’s post office. Continue below.

Has the message file disappeared from the post_office\wpcsout\ofs\6 
directory? 

No The message transferred successfully between post offices, 
but the POA in Post Office B is unable to pick up the file. See 
Step 8 in “Problem with an Individual User in Either Post 
Office” on page 65.

Yes The message transferred successfully between post offices, 
and the POA in Post Office B has picked up the file. If the 
message still does not arrive in the recipient’s mailbox, see 
Step 9 through Step 13 in “Problem with an Individual User in 
Either Post Office” on page 65.

Does the link from the domain to the post office specify the correct IP address, 
UNC path, or mapped path to the post office directory for the recipient’s post 
office?

No Correct the information. Restart the MTA. Observe the MTA 
agent console for any sign of problems. Repeat the test.

Yes The link to recipient’s post office is correct. Continue below.
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7 Check rights for the MTA to write files into the 
post_office\wpcsout\ofs\6 directory in Post Office B. 

8 Check for available disk space in the 
post_office\wpcsout\ofs\6 directory in Post Office B.

9 If these troubleshooting steps have not enabled the MTA to write the file 
into the post_office\wpcsout\ofs\6 directory in the recipient’s 
post office, see Novell Support (http://support.novell.com).

Message Does Not Arrive between Domains

Problem: A message from a user in Domain A is not being delivered to a user in Domain 
B. 

Action: Review the stages of message flow between domains. See “Message Delivery 
to a Different Domain” in GroupWise 7 Troubleshooting 3: Message Flow and 
Directory Structure.

Action: Answer the question below:

Are the IP address and TCP port number for the POA correct?

No Correct the information. Restart the POA in Post Office B. 
Observe the POA agent console for any sign of problems. 
Repeat the test.

Yes The IP address and port for the POA are correct. Continue 
below.

Are the network rights in the post office correct?

No Reset the rights in the post office, and repeat the test.

Yes Continue below.

Is there adequate disk space available in the post office?

No Remove unnecessary files from the server to free up disk space, 
then repeat the test. 

Yes Continue below.

Can other users in Domain A send messages to other users in Domain B?

Yes See “Problem with an Individual User in Either Domain” on 
page 70.

No See “Problem between Domains for Multiple Users” on page 71.

Don’t Know See “Problem between Domains for Multiple Users” on page 71.
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Problem with an Individual User in Either Domain 

1 Stop the MTA for Domain A.
2 Have the user in Domain A send a low priority test message to a recipient 

in Domain B. (It’s a good idea to test message flow using a low priority 
message because the low priority message queue is typically empty.) 

3 Check the post_office\wpcsin\6 directory in the sender’s post 
office. 

4 Stop the POA for the recipient’s post office in Domain B.
5 Start the MTA for Domain A. Observe the MTA agent console for any 

sign of problems.
6 Check the domain\wpcsin\6 directory in Domain B. 

7 Restart the POA for the recipient’s post office in Domain B. Observe the 
POA agent console for any sign of problems.

8 Recheck the post_office\wpcsout\ofs\6 directory in the 
recipient’s post office in Domain B. 

9 Check the recipient’s mailbox.

Has a new message file appeared in the post_office\wpcsin\6 directory?

No The GroupWise client was unable to create the message 
files. The user might not have sufficient rights to the directory. 
Correct the problem, then repeat the test.

Yes The sender can successfully send messages. Continue 
below.

Has a new message file appeared in the domain\wpcsin\6 directory?

No The message is not transferring between domains. See 
“Problem between Domains for Multiple Users” on page 71.

Yes The message transferred successfully between domains. 
Continue below.

Has the message file disappeared from the post_office\wpcsout\ofs\6 
directory?

No The POA was unable to pick up the message. Correct the 
problem, then repeat the test.

Yes The POA has successfully picked up the message. Continue 
below.

Does the new message appear in the recipient’s mailbox?

Yes The POA has successfully delivered the message this time. 
Repeat the test with a different user.
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10 Check the ownership of the recipient’s user database (userxxx.db). 

11 Check the ownership of the message database (msgnnn.db) in the 
recipient’s post office that corresponds to the message database assigned 
to the sender in the sender’s post office.

12 In ConsoleOne, perform maintenance to correct any problems with the 
databases. See “Maintaining User/Resource and Message Databases” in 
“Databases” in the GroupWise 7 Administration Guide. Then repeat the 
test.

13 If the message flow problem has not been resolved by following the 
above troubleshooting steps, see Novell Support (http://
support.novell.com).

Problem between Domains for Multiple Users 

1 Stop the MTA for Domain A.
2 Have the user in Domain A send a low priority test message. (It’s a good 

idea to test message flow using a low priority message because the low 
priority message queue is typically empty.) 

3 Check the post_office\wpcsin\6 directory in the sender’s post 
office. 

4 Stop the POA and the MTA for Domain B.

No The POA was unable to deliver the message. Continue 
below.

Does the ownership of the user database match the recipient’s network login 
ID?

No Reset the ownership on the user database, then repeat the 
test.

Yes Continue below.

Is the ownership of the message database correct?

No Reset the ownership on the message database, then repeat 
the test.

Yes Continue below.

Has a new message file appeared in the post_office\wpcsin\6 directory?

No See “Problem with an Individual User in Either Domain” on 
page 70.

Yes The sender can successfully send messages. Continue 
below.

Does the new message appear in the recipient’s mailbox?
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5 Restart the MTA for Domain A. Observe the MTA agent console for any 
sign of problems.

6 Check the domain\wpcsin\6 directory in Domain B. 

7 Restart the MTA for Domain B. Observe the MTA agent console for any 
sign of problems.

8 Check the post_office\wpcsout\ofs\6 directory in the 
recipient’s post office. 

9 Restart the POA for the recipient’s post office in Domain B. Observe the 
POA agent console for any sign of problems.

10 Recheck the post_office\wpcsout\ofs\6 directory in the 
recipient’s post office.

Problem with Access to Domain B 

1 Start ConsoleOne with read/write rights to the domain.
2 Open the browser window.
3 Double-click the eDirectory container where Domain A is located, then 

select Domain A.
4 Click Tools > GroupWise Utilities > Link Configuration.
5 Check the link from Domain A to Domain B.

Has a new message file appeared in the domain\wpcsin\6 directory?

No See “Problem with Access to Domain B” on page 72.

Yes The file has successfully transferred to Domain B. Continue 
below. 

Has a new message file appeared in the post_office\wpcsout\ofs\6?

No See “Problem with Access to the Post Office in Domain B” on 
page 73.

Yes The MTA has successfully transferred the file to the POA in 
the recipient’s post office. Continue below.

Has the message file disappeared from the post_office\wpcsout\ofs\6 
directory?

No The message transferred successfully between domains and 
into the recipient’s post office, but the POA in the recipient’s post 
office is unable to pick up the file. See Step 8 in “Problem with an 
Individual User in Either Domain” on page 70.

Yes The message transferred successfully between domains and 
into the recipient’s post office, and the POA in the recipient’s 
post office has picked up the file. If the message still does not 
arrive in the recipient’s mailbox, see Step 8 through Step 13 in 
“Problem with an Individual User in Either Domain” on page 70.
7 Troubleshooting 2: Solutions to Common Problems



novdocx (E
N

U
)  01 February 2006
6 If you are using TCP/IP links between domains, check the IP address and 
port displayed in the Network Address box of the MTA Identification 
page. See “Using TCP/IP Links between Domains” in “Message Transfer 
Agent” in the GroupWise 7 Administration Guide. 

7 If you are using mapped or UNC links, check rights for the Domain A 
MTA to write files into the domain\wpcsin\6 directory in Domain B. 

8 Check for available disk space in the domain\wpcsin\6 directory in 
Domain B.

9 If these troubleshooting steps have not enabled the Domain A MTA to 
write the file into the domain\wpcsin\6 directory in Domain B, see 
Novell Support (http://support.novell.com).

Problem with Access to the Post Office in Domain B 

1 Start ConsoleOne with read/write rights to the post office.
2 Open the browser window.
3 Double-click the eDirectory container where Domain B is located, 

then select Domain B.
4 Click Tools > GroupWise Utilities > Link Configuration.

Does the link from Domain A specify the correct IP address, UNC path, or 
mapped path to the domain directory for Domain B?

No Correct the information. Restart the MTA in Domain A. 
Observe the MTA agent console for any sign of problems. 
Repeat the test.

Yes The link to Domain B is correct. Continue below.

Are the IP address and TCP port number for the MTA correct?

No Correct the information. Restart the MTA. Observe the MTA 
agent console for any sign of problems. Repeat the test.

Yes The IP address and port for MTA are correct. Continue below.

Are the network rights in the domain correct?

No Reset the rights in Domain B, and repeat the test.

Yes Continue below.

Is there adequate disk space available in the domain?

No Remove unnecessary files from the server to free up disk 
space, then repeat the test.

Yes Continue below.
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5 Check the link from Domain B to the recipient’s post office. 

6 If you are using a TCP/IP link to the post office, check the IP address 
displayed in the Network Address box of the POA Identification page.

7 If you are using a mapped or UNC link to the post office, check rights for 
the Domain B MTA to write files into the 
post_office\wpcsout\ofs\6 directory in the post office. 

8 Check for available disk space in the 
post_office\wpcsout\ofs\6 directory in the recipient’s post 
office.

9 If these troubleshooting steps have not enabled the Domain B MTA to 
write the file into the post_office\wpcsout\ofs\6 directory in 
the recipient’s post office, see Novell Support (http://support.novell.com).

Message Does Not Arrive Across the Internet

Problem: A message is not successfully delivered between a GroupWise user and an e-
mail user somewhere on the Internet.

Does the link from the domain to the post office specify the correct IP address, 
UNC path, or mapped path to the post office directory for the recipient’s post 
office?

No Correct the information. Restart the MTA in Domain B. 
Observe the MTA agent console for any sign of problems. 
Repeat the test.

Yes The link to recipient’s post office is correct. Continue below.

Is the IP address and TCP port number for the POA correct?

No Correct the information. Restart the POA. Observe the POA 
agent console for any sign of problems. Repeat the test.

Yes The IP address and TCP port number for the POA are 
correct. Continue below.

Are the network rights for the post office correct? 

No Reset the rights in the post office, and repeat the test.

Yes Continue below.

 Is there adequate disk space available in the post office? 

No Remove unnecessary files from the server to free up disk 
space, then repeat the test.

Yes Continue below.
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Action: Review the stages of message flow performed by the Internet to send and 
receive messages across the Internet. See “Message Delivery to and from the 
Internet” in “Message Flow Diagrams” in GroupWise 7 Troubleshooting 3: 
Message Flow and Directory Structure.

Action: The most useful procedure to find the source of a problem when a message is 
not being sent across the Internet is to break the GroupWise send process into 
steps and verify that the message arrives at each destination before the next 
piece receives and delivers it. 

If a message has Pending status in the sender’s Sent Items folder, the message 
is somewhere in the GroupWise system. 

A message has Pending status in the sender’s Sent Items folder until it is 
converted and queued to the SMTP service. The message has Transferred 
status after the Internet Agent queues the message to the SMTP service. If the 
Internet Agent is unsuccessful in sending the message and gets a temporary 
error (for example, Host Down), it attempts to send the message according to 
the Retry Schedule. During this time, the message has Pending status in the 
sender’s Sent Items folder. If the Internet Agent is ultimately unsuccessful in 
sending the message, the sender receives an undeliverable status. 

The following steps provide general guidelines for checking the message at 
each point in the GroupWise system: 

1 Stop the Internet Agent and the Message Transfer Agent. Send a message 
from GroupWise, then look in the post_office_a\wpcsin\0-7 
directory for a file where the client transfers the message. If the file exists, 
verify the time and date stamp of the file and continue with Step 2. If the 
file does not exist, the client did not transfer the file into the 
\wpcsin\0-7 directory. Verify the address of the message and send 
another message to someone else on the Internet.

2 If the file does exist in the post_office_a\wpcsin\0-7 directory, 
then start the Message Transfer Agent. The Message Transfer Agent polls 
the \wpcsin\0-7 directory and places the message in the 
wpgate\gwia\wpcsout\gwixxxx\0-7 directory. (gwixxxx is a 
random directory name generated from information from ConsoleOne.) If 
the file exists, continue to Step 3. 
If the file does not exist in the wpcsout\gwixxxx\0-7 directory, then 
the Message Transfer Agent is not processing the files. See “Message 
Transfer Agent Problems” on page 33. After the MTA is working 
correctly, return to Step 1.

3 After the file is in the \gwixxxx\0-7 directory, start the Internet 
Agent. The file should transfer to the wpgate\gwia\send directory. If 
the file exists in the send directory, continue to Step 4.
If the file does not exist in the \send directory, then the error is written to 
the log file. Look at the log file in the wpgate\gwia\000.prc 
directory. Files sent from GroupWise that have been corrupted are 
transferred to the wpcsout\problem directory. Change the log level to 
Diag, then repeat Step 1 through Step 3. 

4 After the file is delivered to the send directory, exit the Internet Agent.
Message Does Not Arrive 75



76 GroupWise 

novdocx (E
N

U
)  01 February 2006
While the Internet Agent is delivering a message, it builds a file in the 
domain\wpgate\gwia\result directory. As soon as it delivers the 
entire message, check the result directory. 
If the file does not exist in the result directory, then the Internet Agent is 
not working. Check the /dhome and /home switches to ensure that they 
are pointing to the correct directories. 
If the file does exist in the result directory, check the TCP configuration 
or read the file and notice the last part of the message that was sent. You 
should have a file that contains several lines of comments preceded by 
250 (OK reply).

5 If an Internet host is down or the connection is not made on the Internet, 
start the Internet Agent to place the message in the 
wpgate\gwia\defer directory for 20 minutes. The Internet Agent 
transfers the file to the send directory for another attempt at sending to the 
Internet. The Internet Agent defers and re-queues the message according 
to the Retry Schedule. The Internet Agent makes this attempt three times 
in one hour and then every four hours for four days. After the four days, if 
the Internet host remains down, an undeliverable status is sent back to the 
sender.

6 If the file in the result directory does not indicate an error, start the 
Internet Agent again and see if SMTP sends a message back to the 
sender’s post office. In the Client Sent Items folder, check the message 
properties for the message status. At this point, an undeliverable status 
indicates an incorrect Internet address.

7 Messages sent from GroupWise with a Delayed Delivery status do not go 
to the send directory. Instead they reside in the 
wpgate\gwia\gwhold directory until the date the message should be 
sent.

8 If an Internet user receives an undeliverable message because of an 
incorrect address to a Groupwise user, a copy of the message from the 
Internet resides in the wpgate\gwia\gwprob directory. 
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10Message Delivery Is Slow

Select the configuration where message flow is slow:

• “Message Delivery Is Slow in the Local Post Office” on page 77
• “Message Delivery Is Slow between Post Offices” on page 77
• “Message Delivery Is Slow between Domains” on page 78

Message Delivery Is Slow in the Local Post Office

Problem: Message delivery between GroupWise® users in the same post office is slower 
than desired.

Action: Review the stages of message flow within the local post office. See “Message 
Delivery in the Local Post Office” in GroupWise 7 Troubleshooting 3: 
Message Flow and Directory Structure.

Possible Cause: The POA has been installed on a server with insufficient system resources.

Action: Check the utilization and memory on the server where the POA is running to 
see if other programs are taking more resources than usual. If the POA has 
fewer resources than usual, it can take longer to deliver messages. Make sure 
the server still meets the system requirements for running the POA. See 
“Agent System Requirements” in “Installing GroupWise Agents” in the 
“GroupWise 7 Installation Guide”. 

Possible Cause: The POA is not configured optimally.

Action: Go to the server where the POA is running. Check the POA agent console to 
see how busy the POA is. If the POA is very busy, it can take longer to deliver 
messages. If the POA needs to handle the current load on a permanent basis, 
see “Optimizing the POA” in “Post Office Agent” in the GroupWise 7 
Administration Guide.

Action: TCP/IP links between the GroupWise client and the post office can be faster 
than mapped drive connections. If you are currently using mapped drive 
connections and have TCP/IP available, you could change the configuration of 
the client and POA to use TCP/IP links instead. See “Using Client/Server 
Access to the Post Office”in “Post Office Agent” in the GroupWise 7 
Administration Guide. 

Message Delivery Is Slow between Post Offices

Problem: Message delivery between GroupWise users in different post offices in the 
same domain is slower than desired. 

Action: Review the stages of message flow between post offices. See “Message 
Delivery to a Different Post Office” in GroupWise 7 Troubleshooting 3: 
Message Flow and Directory Structure.

Action: If message delivery between users in the same post office is also slower than 
desired, see “Message Delivery Is Slow in the Local Post Office” on page 77. 
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Resolve problems in local post offices first before troubleshooting problems 
between post offices.

Possible Cause: The MTA has been installed on a server with insufficient system resources.

Action: Check the utilization and memory on the server where the MTA is running to 
see if other programs are taking more resources than usual. If the MTA has 
fewer resources than usual, it can take longer to deliver messages between post 
offices. Make sure the server still meets the system requirements for running 
the MTA. See “Agent System Requirements” in “Installing GroupWise 
Agents” in the “GroupWise 7 Installation Guide”. 

Possible Cause: The MTA is not configured optimally.

Action: Go to the server where the MTA is running. Check the MTA agent console to 
see how busy the MTA is. If the MTA is very busy, it can take longer to deliver 
messages between post offices. If the MTA needs to handle the current load on 
a permanent basis, see “Optimizing the MTA” in “Message Transfer Agent” in 
the GroupWise 7 Administration Guide.

Possible Cause: The network itself is busy.

Action: Check network traffic between the servers where the POA and MTA are 
running. Heavy network traffic can slow down the transfer of GroupWise 
messages between post offices.

Possible Cause: If the MTA has received a large number of administrative messages, user 
messages might be delayed because administrative messages are of higher 
priority.

Action: Check the MTA log file to see what types of messages the MTA is currently 
processing. See “Using MTA Log Files” in “Message Transfer Agent” in the 
GroupWise 7 Administration Guide. After high priority administrative 
messages are processed, user messages are processed.

Message Delivery Is Slow between Domains

Explanation: Message delivery between GroupWise users in different domains is slower 
than desired. 

Action: Review the stages of message flow between domains. See “Message Delivery 
to a Different Domain” in GroupWise 7 Troubleshooting 3: Message Flow and 
Directory Structure.

Action: If message delivery between users in the same post office is also slower than 
desired, see “Message Delivery Is Slow in the Local Post Office” on page 77. 
Resolve problems in local post offices first before troubleshooting problems 
between post offices or domains.

Action: If message delivery between users in different post offices in the same domain 
is also slower than desired, see “Message Delivery Is Slow between Post 
Offices” on page 77. Resolve problems between post offices before 
troubleshooting problems between domains.

Possible Cause: The MTA has been installed on a server with insufficient system resources.

Action: Check the utilization and memory on the server where the MTA is running to 
see if other programs are taking more resources than usual. If the MTA has 
fewer resources than usual, it can take longer to deliver messages between 
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domains. Make sure the server still meets the system requirements for running 
the MTA. See “Agent System Requirements” in “Installing GroupWise 
Agents” in the “GroupWise 7 Installation Guide”.

Possible Cause: The MTA is not configured optimally.

Action: Go to the server where the MTA is running. Check the MTA agent console to 
see how busy the MTA is. If the MTA is very busy, it can take longer to deliver 
messages between domains. If the MTA needs to handle the current load on a 
permanent basis, see “Optimizing the MTA” in “Message Transfer Agent” in 
the GroupWise 7 Administration Guide.

Possible Cause: The network itself is busy.

Action: Check network traffic between the servers where the POA and MTA are 
running. Heavy network traffic can slow down the transfer of GroupWise 
messages between domains. Also check general network configuration, 
looking for slow links, congested hubs, and busy subnets that lie along the 
route GroupWise messages must take between domains.

Possible Cause: Links between domains are not configured optimally.

Action: Check the number of hops the message must travel between domains. You can 
view this information for a message in the mailbox of a user who has problems 
with slow message delivery. If messages are being routed through a large 
number of domains, use the Link Configuration Tool in ConsoleOne® to 
design a more efficient route for messages between domains. See 
“Understanding Link Configuration” in “Domains” in the GroupWise 7 
Administration Guide.
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11Message Has Undeliverable Status

Select the configuration where undeliverable messages are occurring:

• “Message Has Undeliverable Status in the Local Post Office” on page 81
• “Message Has Undeliverable Status between Post Offices” on page 81
• “Message Has Undeliverable Status between Domains” on page 82

Message Has Undeliverable Status in the Local Post Office

Problem: A user sends a message to another user in the same post office, and the 
message comes back with a status of Undeliverable. 

Explanation: A status of Undeliverable indicates the user to whom the message is addressed 
does not exist in the post office. 

Possible Cause: The sender manually typed the recipient’s address, rather than selecting it in 
the GroupWise® Address Book, and typed it incorrectly.

Action: Have the sender select the recipient in the GroupWise Address Book so the 
address is provided automatically, then resend the message.

Possible Cause: If the sender is selecting a group, rather than an individual recipient, from the 
GroupWise Address Book, the group could be out of date if the recipient’s user 
ID has changed. 

Action: Re-create the group by selecting each individual user from the Address Book 
to make sure current user IDs are included in the group.

Possible Cause: If the recipient is a new user, the sender might have sent the message before 
the recipient was actually created in the post office. 

Action: Verify the existence of the user in the post office before the sender tries to send 
the message again. 

Possible Cause: The recipient’s mailbox might be damaged so the message cannot be 
delivered. 

Action: In ConsoleOne®, perform maintenance to correct any problems with the 
recipient’s mailbox. See “Maintaining User/Resource and Message Databases” 
in “Databases” in the GroupWise 7 Administration Guide.

Message Has Undeliverable Status between Post Offices

Problem: A user sends a message to a recipient in a different post office, and the 
message comes back with a status of Undeliverable.

Explanation: A status of Undeliverable indicates either that the user to whom the message is 
addressed does not exist in the post office, or that the post office does not exist 
in the domain. 

Possible Cause: The sender manually typed the recipient’s address, rather than selecting it in 
the GroupWise Address Book, and typed it incorrectly.
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Action: Have the sender select the recipient in the GroupWise Address Book so the 
address is provided automatically, then resend the message.

Possible Cause: If the sender is selecting a group from the GroupWise Address Book, rather 
than an individual recipient, the group could be out of date if the recipient’s 
user ID or post office has changed.

Action: Re-create the group by selecting each individual user from the Address Book 
to make sure current user IDs and post offices are included in the group.

Possible Cause: If the recipient is a new user, the sender might have sent the message before 
the recipient was actually created in the post office. 

Action: Verify the existence of the user in the post office before the sender tries to send 
the message again. 

Possible Cause: The recipient’s mailbox might be damaged so the message cannot be 
delivered. 

Action: In ConsoleOne, perform maintenance to correct any problems with the 
recipient’s mailbox. See “Maintaining User/Resource and Message Databases” 
in “Databases” in the GroupWise 7 Administration Guide. 

Message Has Undeliverable Status between Domains

Problem: A user sends a message to a recipient in a different domain, and the message 
comes back with a status of Undeliverable. 

Explanation: A status of Undeliverable indicates that the user to whom the message is 
addressed does not exist in the post office; that the post office does not exist in 
the domain; or that the domain does not exist in the GroupWise system. 

Possible Cause: If the sender is selecting a group from the GroupWise Address Book, rather 
than an individual recipient, the group could be out of date if the recipient’s 
user ID or post office has changed.

Action: Re-create the group by selecting each individual user from the Address Book 
to make sure that current user IDs and post offices are included in the group.

Possible Cause: If the recipient is a new user, the sender might have sent the message before 
the recipient was actually created in the post office. 

Action: Verify the existence of the user in the post office before the sender tries to send 
the message again. 

Possible Cause: The recipient’s mailbox might be damaged so the message cannot be 
delivered. 

Action: In ConsoleOne, perform maintenance to correct any problems with the 
recipient’s mailbox. See “Maintaining User/Resource and Message Databases” 
in “Databases” in the GroupWise 7 Administration Guide.

Possible Cause: If the sender is selecting a group from the GroupWise Address Book, rather 
than an individual recipient, the group could be out of date if the recipient’s 
user ID, post office, or domain has changed. 

Action: Re-create the group by selecting each individual user from the Address Book 
to make sure current user IDs, post offices, and domains are included in the 
group.
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Possible Cause: The sender is mailing to a user in an external GroupWise system and has an 
incorrect address.

Action: Have the sender verify the address with the recipient, then send the message 
again. 

Possible Cause: If the recipient is a new user, the sender might have sent the message before 
the recipient was actually created in the post office. 

Action: Verify the existence of the user in the post office before the sender tries to send 
the message again.

Possible Cause: The recipient’s mailbox might be damaged so the message cannot be 
delivered. 

Action: In ConsoleOne, perform maintenance to correct any problems with the 
recipient’s mailbox. See “Maintaining User/Resource and Message Databases” 
in “Databases” in the GroupWise 7 Administration Guide. 

Possible Cause: Links between domains and post offices are not set up correctly.

Action: Check the link configuration in ConsoleOne to make sure links between 
domains and post offices are set up correctly. See “Understanding Link 
Configuration” in “Domains” in the GroupWise 7 Administration Guide.
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12Message Is Dropped in the 
problem Directory

Select the location of the problem directory:

• “Message Is Dropped in the problem Directory in the Post Office” on page 85
• “Message Is Dropped in the problem Directory in the Domain” on page 85

Message Is Dropped in the problem Directory in the Post Office

Problem: In the Statistics box in an agent console, you notice that some problem 
messages or message errors have been encountered. 

Explanation: Problem messages are message files that cannot be processed by the agents for 
a variety of reasons. Each file has an extension that indicates which agent 
(POA or MTA) placed the file in the post_office\wpcsout\problem 
directory. 

Action: If GroupWise® is currently set up to mail problem messages to the GroupWise 
administrator, check the mailbox of the GroupWise administrator for messages 
with problem message files attached. Follow the instructions in the message 
for handling the problem files.

Action: Sometimes a problem file can be handled successfully if it is requeued. Place 
the file into the proper priority 0 subdirectory, as indicated by the extension on 
the message file. Placing it in the 0 subdirectory gives it high priority for 
reprocessing. If conditions have changed on the network, the message might 
be able to be processed.

If the message still cannot be processed after being requeued, it has been 
damaged in some way that makes it unreadable. This should happen very 
rarely.

Action: If your GroupWise system reports a large number of problem messages, you 
should determine what is causing the damage. See Novell® Support (http://
support.novell.com).

Message Is Dropped in the problem Directory in the Domain

Problem: In the Statistics box in an agent console, you notice that some problem 
messages or message errors have been encountered. 

Explanation: Problem messages are message files that cannot be processed by the agents for 
a variety of reasons. Therefore, they are placed in the 
domain\wpcsout\problem directory.

Action: If GroupWise is currently set up to mail problem messages to the GroupWise 
administrator, check the mailbox of the GroupWise administrator for messages 
with problem message files attached. Follow the instructions in the message 
for handling the problem files.
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Possible Cause: Files placed in the problem directory in the domain have been damaged in 
some way that makes them unreadable.

Action: None. This should happen very rarely.

Action: If your GroupWise system reports a large number of problem messages, you 
should determine what is causing the damage. See Novell Support  (http://
support.novell.com).
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IVStrategies for Administration 
Problems

This part of Troubleshooting 2: Solutions to Common Problems helps you resolve problems running 
the GroupWise® Administrator snap-in to ConsoleOne® and problems managing GroupWise 
Document Management Services (DMS) and covers the following sections:

• Chapter 13, “GroupWise Administrator Snap-In to ConsoleOne Problems,” on page 89
• Chapter 14, “Document Management Services Problems,” on page 93

Other sources of assistance include:

• Novell® Support (http://support.novell.com)
• Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp)
• GroupWise 7 Support Forums (http://support.novell.com/forums/2gw.html)
• Novell GroupWise Support Community (http://support.novell.com/products/groupwise)
• GroupWise Cool Solutions (http://www.novell.com/coolsolutions/gwmag/index.html)
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13GroupWise Administrator Snap-In 
to ConsoleOne Problems

This section suggests ways to fix the following problems:

• “ConsoleOne Can’t Access the Domain Database” on page 89
• “You Aren’t Connected to the Right GroupWise Domain” on page 90
• “You Can’t Create or Delete GroupWise Objects” on page 90
• “Pending Operations Aren’t Completed” on page 90
• “Creation of a Secondary Domain Isn’t Completed” on page 90
• “Addressing Rules Aren’t Working” on page 91
• “Synchronization Isn’t Working” on page 91
• “You Can’t Move a User” on page 91
• “eDirectory Objects Aren’t Linking to GroupWise Objects” on page 92

See also “Administration Error Messages” in GroupWise 7 Troubleshooting 1: Error Messages.

ConsoleOne Can’t Access the Domain Database

Problem: You run ConsoleOne® but cannot access the domain where you need to make 
changes.

Possible Cause: You have not yet authenticated to an eDirectoryTM tree. On Linux, ConsoleOne 
does not automatically connect to the same domain database you were 
connected to during the previous ConsoleOne session.

Action: Manually connect. See “Connecting to a Domain” in “Domains” in the 
GroupWise 7 Administration Guide.

Possible Cause: You are not connected to the correct domain.

Action: Make sure you are connected to the correct domain. See “Connecting to a 
Domain” in “Domains” in the GroupWise 7 Administration Guide.

Possible Cause: You don’t have sufficient rights.

Action: Make sure you started ConsoleOne with sufficient rights to modify the 
Domain object.

Possible Cause: The domain database (wpdomain.db) is damaged.

Action: Rebuild the domain database. See “Rebuilding Domain or Post Office 
Databases” in “Databases” in the GroupWise 7 Administration Guide.

Possible Cause: The domain database (wpdomain.db) is locked. Because ConsoleOne is 
designed to allow multiple administrators to access databases simultaneously, 
this theoretically should not happen, but occasionally it does.

Action: Exit ConsoleOne and restart.
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You Aren’t Connected to the Right GroupWise Domain

Problem: You are attempting to modify a GroupWise® object in ConsoleOne. A message 
informs you that you cannot perform the action because you are not connected 
to the correct GroupWise domain. 

Action: Connect to the correct GroupWise domain. See “Connecting to a Domain” in 
“Domains” in the GroupWise 7 Administration Guide.

You Can’t Create or Delete GroupWise Objects

Problem: You are running ConsoleOne to create or delete a GroupWise object. However, 
you are unable to perform the action. 

Possible Cause: You are not connected to the correct domain.

Action: Make sure you are connected to the correct domain. See “Connecting to a 
Domain” in “Domains” in the GroupWise 7 Administration Guide. 

Possible Cause: You do not have sufficient eDirectory rights.

Action: Make sure you started ConsoleOne with sufficient rights to the GroupWise 
object.

Possible Cause: You do not have sufficient file system rights.

Action: Make sure you have sufficient rights to the directory structure associated with 
the GroupWise domain or post office. See “GroupWise Administrator Rights” 
in “Security Administration” in the GroupWise 7 Administration Guide.

Pending Operations Aren’t Completed

Problem: You have performed some actions on GroupWise objects in ConsoleOne. You 
see them listed in the Pending Operations dialog box, but they are not 
completed. 

Action: Use the Retry option or the Undo option in the Pending Operations dialog box. 
See “Pending Operations” in “System” in the GroupWise 7 Administration 
Guide. 

Action: Check the MTA log files to see if the administrative message has been 
delivered. See “Using MTA Log Files” in “Message Transfer Agent” in the 
GroupWise 7 Administration Guide. 

Possible Cause: The MTA is not running.

Action: Make sure that the MTA is running and that no post offices or domains are 
closed. See “Monitoring the MTA” in “Message Transfer Agent” in the 
GroupWise 7 Administration Guide.

Creation of a Secondary Domain Isn’t Completed

Problem: You are creating a secondary domain, but the process is interrupted before 
completion. For example, you click Cancel, or a power failure or hardware 
failure occurs. The result is that the new secondary domain appears in the 
GroupWise view but does not appear in the eDirectory tree. 

Action: First, graft the new secondary domain into the eDirectory tree. See “GW / 
eDirectory Association” in “System” in the GroupWise 7 Administration 
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Guide. Next, select the secondary domain in the eDirectory tree, then rebuild 
it. See “Rebuilding Domain or Post Office Databases” in “Databases” in the 
GroupWise 7 Administration Guide.

Addressing Rules Aren’t Working

Problem: You created an addressing rule; however, it isn’t working for users in the 
GroupWise client. 

Possible Cause: You didn’t enable the addressing rules after creating them.

Action: Addressing rules must be enabled after being created. See “Enabling an 
Addressing Rule” in “System” in the GroupWise 7 Administration Guide. 

Possible Cause: The addressing rules haven’t replicated to the user’s post office.

Action: Rebuild the post office database (wphost.db). See “Rebuilding Domain or Post 
Office Databases” in “Databases” in the GroupWise 7 Administration Guide.

Synchronization Isn’t Working

Problem: The MTA automatically synchronizes information throughout your 
GroupWise system. However, you notice that some GroupWise information is 
not being synchronized. 

Action: Manually synchronize the information in ConsoleOne. See “Synchronizing 
Database Information” in “Databases” in the GroupWise 7 Administration 
Guide.

You Can’t Move a User

Problem: You attempt to move a user from one post office to another, but the user does 
not appear in the destination post office. 

Possible Cause: The agents aren’t functioning properly.

Action: Make sure the MTA and POA are configured correctly and are running. See 
“Message Transfer Agent” and “Post Office Agent” in the GroupWise 7 
Administration Guide.

Possible Cause: The move hasn’t been completed yet.

Action: If you are moving a user from one domain to another, view the pending 
operations to see if the operation is complete. See “Pending Operations” in 
“System” in the GroupWise 7 Administration Guide. You can also use the 
Move User Status utility to watch the progress of user moves. See “Monitoring 
User Move Status” in “Users” in the GroupWise 7 Administration Guide.

Possible Cause: The move failed.

Action: Check the MTA and POA log files to see if the process failed. If so, repeat the 
move.

Possible Cause: There is insufficient disk space in the destination post office.

Action: Verify that the post office to which you are moving the user has sufficient free 
disk space.
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eDirectory Objects Aren’t Linking to GroupWise Objects

Problem: In ConsoleOne, eDirectory objects are not linking successfully to GroupWise 
objects. 

Action: Record the conditions under which you encountered the problem. See Novell® 
Support (http://support.novell.com).
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14Document Management Services 
Problems

This section suggests ways to fix the following problems:

• “Documents Are Not Listed in User’s Folder” on page 93
• “User Can’t Exit GroupWise Because a Document Isn’t Closed” on page 93
• “GroupWise Can’t Monitor a Non-Integrated Application” on page 93
• “User Wants to Turn Off Integrations Temporarily” on page 94
• “Administrator Wants to Remove Integrations Permanently” on page 95
• “Administrator Wants to Add a Custom Integration” on page 95
• “Administrator Wants to Distribute Standardized Integrations” on page 96

Documents Are Not Listed in User’s Folder

Problem: A user creates or imports a document in the GroupWise® Windows client. The 
document does not appear in the folder where the user expects to find it. 

Action: On the GroupWise client toolbar, click Show Personal Items. Documents are 
considered personal items and are not listed when personal items are filtered 
out. 

User Can’t Exit GroupWise Because a Document Isn’t Closed

Problem: A user edits a document in a non-integrated application. The user has exited 
the application. However, when the user tries to exit the GroupWise Windows 
client, the client indicates that a document is still open or has not been returned 
to the GroupWise library. 

Action: Click Yes in the error dialog box to let GroupWise attempt to return the 
document to the GroupWise library.

Action: Locate the open document and make sure it is closed properly. Look in the 
Work in Progress folder for open documents.

GroupWise Can’t Monitor a Non-Integrated Application

Problem: The user edits a document and the GroupWise Windows client indicates the 
application cannot be monitored. Therefore, the user must return the document 
to the GroupWise library manually. 

Explanation: The manner in which the GroupWise client monitors applications can be 
modified using settings in the gwappint.inf file, located in the 
\windows\system directory. This file contains information about 
integrating applications and monitoring non-integrated applications that are 
started from the GroupWise client. 

Possible Cause: Some applications, such as WordPerfect* 7.0 and Lotus* Word Pro 96, are 
integrated through ODMA. Other applications, such as Microsoft* Word 7.0 
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and Excel 7.0, are integrated through application macros. If an integrated 
application is not set up correctly, it is handled as a non-integrated application. 

Normally, Setup detects if an application is installed and then allows the user 
to choose whether or not to have integrations installed for that application. If 
the application setup didn’t run correctly, the GroupWise client might not 
detect that the integration installed. If necessary, integrations can be installed 
manually.

Action: For ODMA applications, the gwappint.inf file needs to contain an 
Integrations=2 entry for the application. In addition, the following DLL 
programs are copied to the \windows\system directory when Setup is run: 
odma32.dll, gwodm132.dll, and gwodm1xx.dll. The name of the 
gwodm1xx.dll depends on which language was selected when Setup was 
run. 

Action: For applications that use an integration macro, the gwappint.inf file needs 
to contains an Integrations=1 entry for the application. There should 
also be an integration macro installed in the application’s macro startup 
directory.

Possible Cause: For non-integrated applications, the GroupWise client attempts to monitor 
when an application terminates so open documents can be returned to the 
GroupWise library automatically. If the GroupWise client wasn’t able to 
determine the information needed to monitor the application termination, the 
user is instructed to return documents manually. 

Action: Return documents manually. Save and exit each document. In the GroupWise 
client, right-click each document reference, then click Actions > Reset 
Document Status.

Possible Cause: Some applications do not start quickly enough for the GroupWise client to 
detect that they have started.

Action: You can change the amount of time the GroupWise client allows for the 
application to start using the WaitInterval setting. 

Action: If problems persists, you can turn off the message for the application. Use 
ShowMessage=0 in the gwappint.inf file to turn off the message. 

Action: See the gwappint.inf file in the \windows\system directory for more 
information.

User Wants to Turn Off Integrations Temporarily

Problem: The user wants to turn off application integrations so the GroupWise Windows 
client no longer performs document management functions when the 
application is used. However, the user wants to be able to turn integrations 
back on easily. 

Action: You can turn off integration for all integrated applications. From the Tools 
menu in the GroupWise client, click Options > Documents, then deselect 
Enable Integration with Other Applications. This turns off all integrations. 
You cannot turn off integration for an individual application and leave other 
applications integrated. 
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Administrator Wants to Remove Integrations Permanently

Problem: The administrator wants to permanently turn off one or more application 
integrations so the GroupWise Windows client no longer performs document 
management functions. 

Action: Have users rerun GroupWise client Setup and deselect integrated applications 
so they are no longer integrated when the client software is updated. Then the 
macro must be removed from the startup directories for Microsoft Word or 
Excel as described below.

Action: The administrator can edit the gwappint.inf file, located in the 
\windows\system directory, to remove the integration information. 

• Integrations=2:  If an application has the setting Integrations=2 
for an ODMA-compliant application, you can change to 
Integrations=0 for no integration. 

• Integrations=1: If an application has the setting Integrations=1, 
indicating it is integrated using a startup macro, you must change to 
Integrations=0 for no integration and delete the startup macro. For 
example, to remove integration for Word, you need to delete the 
gwnormxx.dot macro from the Word startup directory. For Excel, you 
need to delete the gwxl95.xla macro from the xlstart directory and 
reset the Excel toolbars.

Administrator Wants to Add a Custom Integration 

Problem: The administrator wants to integrate a new application with the GroupWise 
Windows client. 

Explanation: Integrations are set up using the gwappint.inf file, located in the 
\windows\system directory. This file contains information about integrating 
applications started from the GroupWise client. It can be edited using an 
ASCII or ANSI text editor. 

Action: To integrate a new application, create a new section in the gwappint.inf file by 
surrounding the name of the program with square brackets. For example, 
[WPWIN.EXE]. Use the following options to define the integration: 

•  Integrations=2:  If the application is ODMA-compliant, specify 
Integrations=2.

• Integrations=1:  If the application has its own macro language and you 
want to write a startup macro, use Integrations=1, followed by 
AppKey=application_name. Use the application to create the 
startup macro and place the startup macro in the application’s startup 
directory. 

• DualExe:  For some applications, the name of the file containing the 
actual application is different from what you type to start the application. 
For example, to start WordPerfect 6.1, you type WPWIN, but the 
WordPerfect 6.1 program is actually contained in a file named 
wpwin61.exe. For such applications, you use the name of the program 
that starts the application as the section heading. For example, 
[WPWIN.EXE]. Then you use DualExe to specify the name of the file 
that actually contains the application. For example, 
Document Management Services Problems 95



96 GroupWise 

novdocx (E
N

U
)  01 February 2006
dualexe=wpwin61.exe. You would need to consult the application 
documentation or its installation directory to determine the filename to 
use with DualExe.

Administrator Wants to Distribute Standardized Integrations

Problem: You have created a custom integration between a new application and the 
GroupWise Windows client. You want all GroupWise users to have access to 
this new integration. 

Action: You can distribute copies of the updated gwappint.inf file for all users to 
place in their \windows\system directories. This file is not replaced when 
Setup is run; therefore, customizations are preserved through updates. 
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VStrategies for Client Problems

This part of Troubleshooting 2: Solutions to Common Problems helps you resolve problems users 
encounter when running the GroupWise® Windows client, Remote client, or Cross-Platform client 
and covers the following sections:

• Chapter 15, “GroupWise Client Problems,” on page 99
• Chapter 16, “GroupWise Remote Problems,” on page 105

Other sources of assistance include:

• Novell® Support (http://support.novell.com)
• Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp)
• GroupWise 7 Support Forums (http://support.novell.com/forums/2gw.html)
• Novell GroupWise Support Community (http://support.novell.com/products/groupwise)
• GroupWise Cool Solutions (http://www.novell.com/coolsolutions/gwmag/index.html)
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15GroupWise Client Problems

Most of these problems can occur in either the GroupWise® Windows client or the Cross-Platform 
client, and the same solutions are applicable to both.

• “User Can’t Start the GroupWise Client” on page 99
• “User Receives an Error Message and Code” on page 100
• “User Forgets His or Her GroupWise Password” on page 100
• “User Isn’t Notified of New Messages” on page 100
• “User Can’t Access Archived Messages” on page 100
• “Wrong Date/Time Appears in Messages” on page 101
• “Status Isn’t Being Returned for Sent Messages” on page 101
• “User’s Message Isn’t Delivered” on page 102
• “Users Don’t Appear in the Address Book or Appear Multiple Times” on page 102
• “Screen Information Isn’t Being Updated Immediately” on page 102
• “User Is Notified of a New Message But the Message Isn’t Received” on page 102
• “User Experiences a Delay When Starting the Client or Using Certain Client Features” on 

page 103
• “User Experiences a Delay When Viewing or Printing” on page 103

User Can’t Start the GroupWise Client

Problem: A user can’t start the GroupWise client.

Possible Cause: The user doesn’t exist in the post office yet.

Action: Verify that you’ve added the user to a post office. See “Creating GroupWise 
Accounts” in “Users” in the GroupWise 7 Administration Guide.

Possible Cause: If using client/server access, the user’s TCP/IP information might be incorrect. 

Action: Make sure the user’s post office is set up for client/server access. See “Using 
Client/Server Access to the Post Office” in “Post Office Agent” in the 
GroupWise 7 Administration Guide.

Action: Set up a GroupWise name server. See “Simplifying Client/Server Access with 
a GroupWise Name Server” in “Post Office Agent” in the GroupWise 7 
Administration Guide.

Action: Use the /ipa and /ipp client startup switches to provide the correct IP address 
and TCP port information.

Possible Cause: Multiple users have the same network ID.

Action: If users share the same network ID, but have different GroupWise user IDs, 
start the GroupWise client using the /@u client startup switch.
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User Receives an Error Message and Code

Explanation: The user receives an error message and code while using the GroupWise 
client. 

Action: See “GroupWise Engine Error Codes” in GroupWise 7 Troubleshooting 1: 
Error Messages. If the error code you received is not in the list provided, 
standard solutions are not yet available.

Action: Use the Search feature of the GroupWise online documentation to locate a 
GroupWise error code or message text. If the error you received is not found, 
standard solutions are not yet available.

Action: If you cannot locate the specific error message or the suggested actions do not 
resolve the problem, see “General Troubleshooting Strategies” on page 9.

User Forgets His or Her GroupWise Password

Problem: The user places a password on his or her GroupWise mailbox, then later 
forgets it. 

Action: Use ConsoleOne® to reset the user’s password. See “Creating or Changing a 
Mailbox Password” in “Users” in the GroupWise 7 Administration Guide. 
Then notify the user of the new password. 

User Isn’t Notified of New Messages

Problem: The user does not receive notifications when new GroupWise messages arrive. 

Possible Cause: The user hasn’t turned on the Notify feature yet.

Action: Make sure Notify is turned on in the user’s GroupWise Windows client and the 
user is subscribed to Notify. See “Running Notify” in “Managing Your 
Mailbox” in the “GroupWise 7 Windows Client User Guide”.

Possible Cause: Notify isn’t running on the user’s Windows workstation.

Action: Make sure Notify is running for the user. By default, Notify is added to the 
user’s Startup group when GroupWise Setup runs, but the user might have 
removed it. If necessary, rerun Setup to place Notify in the user’s Startup 
group.

Possible Cause: The user is using the GroupWise Cross-Platform client, which does not include 
the Notify feature.

Action: Be patient. This feature is scheduled for inclusion in a future release of the 
Cross-Platform client.

User Can’t Access Archived Messages

Explanation: The user has archived GroupWise messages onto the hard disk of his or her 
computer. Later, the user cannot access the archived messages. 

Possible Cause: The user doesn’t have an archive path set or has an invalid archive path set.

Action: Verify that the archive path specified under File Location in the GroupWise 
client is valid. See “Archiving the Items in Your Mailbox” in “Managing Your 
Mailbox” in the “GroupWise 7 Windows Client User Guide” or “Archiving the 
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Items in Your Mailbox” in “Managing Your Mailbox” in the “GroupWise 7 
Cross-Platform Client User Guide”.

Possible Cause: The user’s archive is damaged.

Action: The GroupWise client automatically fixes most problems it detects with 
archive databases each time it starts. In addition, you can run GWCheck to fix 
more difficult problems the client can’t handle. See “GroupWise Check” in 
“Standalone Database Maintenance Programs” in the GroupWise 7 
Administration Guide.

Possible Cause: The user is using the GroupWise WebAccess client, which does not currently 
allow you to access your archive.

Action: Use the Windows client or the Cross-Platform client when you need to access 
your archive.

Wrong Date/Time Appears in Messages

Problem: The wrong date or time or both appear in GroupWise messages. 

Possible Cause: The time zone and daylight saving time information for the user’s post office 
and/or domain are incorrect.

Action: Use ConsoleOne to check the Domain and Post Office objects to make sure the 
time zone and daylight saving time settings are correct. See “Time Zones” in 
“System” in the GroupWise 7 Administration Guide.

Possible Cause: The local time on the user’s workstation is incorrect.

Action: Check the local time on the user’s workstation.

Possible Cause: The local time of the servers where the GroupWise agents are running is 
incorrect.

Action: Check the local time of the server where the GroupWise agents are running.

Status Isn’t Being Returned for Sent Messages

Problem: The user is unable to determine if recipients have received messages because 
no status information appears in the user’s mailbox. 

Possible Cause: The user has turned off status tracking.

Action: Ensure that the user’s GroupWise client is configured to track status 
information. See “Confirming Delivery of Items You've Sent” in “Working 
with Items in Your Mailbox” in the “GroupWise 7 Windows Client User 
Guide” or “Confirming Delivery of Items You've Sent” in “Working with 
Items in Your Mailbox” in the “GroupWise 7 Cross-Platform Client User 
Guide”.

Possible Cause: Status information has been turned off for a gateway through which messages 
must pass.

Action: Check the status level set for the gateway. In ConsoleOne, right-click the 
Gateway object, then click Properties. Click Optional Gateway Settings, 
then check the selected Outbound Status Level setting.
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User’s Message Isn’t Delivered

Problem: The user sends a GroupWise message, but one or more recipients do not 
receive it. 

Possible Cause: The user elected to delay delivery.

Action: Ensure that the user does not have Delay Delivery selected in the GroupWise 
Windows client. See “Delaying Delivery of an Item” in “Customizing 
GroupWise” in the GroupWise 7 Windows Client User Guide.

Possible Cause: Message transfer has been interrupted at some point between sender and 
recipients.

Action: Check the user’s mailbox for status information.

Action: For additional strategies, see “Strategies for Message Delivery Problems” on 
page 63.

Users Don’t Appear in the Address Book or Appear Multiple Times

Problem: Valid GroupWise users are missing from the Address Book or are listed more 
than once. 

Possible Cause: The user’s visibility has been set so the user is not visible to other users even 
though the user exists.

Action: Use ConsoleOne to check the users’ visibility. See “Controlling Object 
Visibility” in “System” in the GroupWise 7 Administration Guide. 

Possible Cause: User information in the local post office is not synchronized with the rest of 
the GroupWise system.

Action: Use ConsoleOne to synchronize the users’ information. See “Synchronizing 
Individual Users or Resources” in “Databases” in the GroupWise 7 
Administration Guide.

Screen Information Isn’t Being Updated Immediately

Problem: The user performs an action in the GroupWise client but does not see the 
results of that action. For example, the user sends a message but does not see 
that message in the mailbox. Or the user deletes sent messages from the 
mailbox but the messages are still displayed. 

Action: By default, the GroupWise Windows client updates the screen once every 
minute. Users can specify a shorter update interval in the client so their screen 
information is updated more frequently; this also increases network traffic 
because the client is polling the users’ mailboxes more often. In the 
GroupWise Windows client, click Tools > Options, then double-click 
Environment. Click General, then adjust the Refresh Interval setting. 

User Is Notified of a New Message But the Message Isn’t Received

Problem: A Windows user receives notification that a new GroupWise message has 
arrived but the message does not appear in the user’s mailbox. 

Possible Cause: The message might have been retracted by the sender before the recipient 
could open it.
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Action: None.

Possible Cause: The message might have had a rule or filter applied to it.

Action: Have the user check for unwanted rules or filters in the GroupWise Windows 
client. See “Creating Rules” and “Filtering Items” in “Managing Your 
Mailbox” in the “GroupWise 7 Windows Client User Guide”.

Possible Cause: Message transfer has been interrupted at some point between sender and 
recipients.

Action: For additional strategies, see “Strategies for Message Delivery Problems” on 
page 63.

User Experiences a Delay When Starting the Client or Using Certain Client Features

Problem: The client user connects to the post office in client/server mode. DNS names 
have been configured on the system. The client user experiences a lengthy 
delay when performing one of the following activities:

• Starting the GroupWise client
• Accessing a shared folder for the first time
• Accessing a query folder where sources are located in a different post 

office
• Using Find where sources are located in a different post office
• Accessing the Address Book for the first time
• Performing a cross-post office proxy

Possible Cause: The DNS search order for the user’s workstation includes unavailable DNS 
servers.

Action: Make sure the client workstation has the DNS search order set up correctly. 
The features listed above often require IP address information. If your system 
is configured with DNS names, these must be resolved to IP addresses by the 
client as these features are used. For each unavailable DNS server (IP address) 
that precedes an available DNS server in the configured search order, the client 
experiences a delay while timing out waiting to resolve DNS names.

User Experiences a Delay When Viewing or Printing

Problem: A user experiences a lengthy delay when performing one of the following 
activities in the GroupWise client:

• Viewing an attachment
• Viewing a document
• Viewing mailbox items using QuickViewer
• Viewing item properties
• Printing items or attachments

Possible Cause: The user does not have a default printer set up.

Action: Make sure the user has a valid default printer defined. Printer information is 
used for viewing as well as printing.
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16GroupWise Remote Problems

This section suggests ways to fix the following problems:

• “User Cannot Connect to the Master GroupWise System” on page 105
• “Remote Message Flow Is Blocked” on page 105
• “Remote Mailbox Is Damaged” on page 105

See also “Remote Mode Windows Client Error Messages” in GroupWise 7 Troubleshooting 1: Error 
Messages.

User Cannot Connect to the Master GroupWise System

Problem: You cannot establish a connection from GroupWise® Remote to your master 
GroupWise system.

Action: Use the Remote Connection Log to display connection information and to 
troubleshoot connection problems. This log includes information about 
connection time, error messages, and so forth. 

GroupWise uses three files to log the connection information. These files are 
remote1.log, remote2.log, and remote3.log. GroupWise uses the 
next log file each time you run GroupWise Remote against your Remote 
mailbox. 

If you want to save the transmission information, select the information you 
want to save, right-click the connection log, then click Copy. You can save this 
information in a text file. 

Remote Message Flow Is Blocked

Problem: Messages are not being transferred to/from GroupWise Remote.

Action: To see how a message should travel to and from GroupWise Remote, see 
“Message Delivery through a Modem Connection” in GroupWise 7 
Troubleshooting 3: Message Flow and Directory Structure. 

Remote Mailbox Is Damaged

Problem: GroupWise Remote is not functioning correctly because it cannot access its 
Remote mailbox.

Action: Verify that the structure of the Remote mailbox is correct. See “Remote 
Mailbox Directory” in GroupWise 7 Troubleshooting 3: Message Flow and 
Directory Structure. 

Action: Repair the Remote mailbox. See “GroupWise Check” in “Standalone Database 
Maintenance Programs” in the GroupWise 7 Administration Guide.
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107

ADocumentation Updates

This section lists updates to GroupWise 7 Troubleshooting 2: Solutions to Common Problems that 
have been made since the initial release of GroupWise® 7. The information will help you to keep 
current on documentation updates and, in some cases, software updates (such as a Support Pack 
release).

The information is grouped according to the date when the GroupWise 7 Troubleshooting 2: 
Solutions to Common Problems was republished. Within each dated section, the updates are listed 
by the names of the main table of contents sections.

GroupWise 7 Troubleshooting 2: Solutions to Common Problems has been updated on the following 
dates:

• Section A.1, “June 15, 2006,” on page 107

A.1  June 15, 2006

Location Change

Entire Guide Page design reformatted to comply with revised Novell documentation 
standards.
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